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Safety and approval information

This Rosemount product complies with all applicable European directives when properly installed in accordance with
the instructions in this manual. Refer to the EU Declaration of Conformity for directives that apply to this product. The
EU Declaration of Conformity, with all applicable European directives, and the complete ATEX installation drawings
and instructions are available on the Internet at Emerson.com or through your local Emerson support center.
Information affixed to equipment that complies with the Pressure Equipment Directive can be found on the Internet
at Emerson.com.
For hazardous installations in Europe, refer to standard EN 60079-14 if national standards do not apply.

Other information
Full product specifications can be found in the product data sheet. Troubleshooting information can be found in the
maintenance and troubleshooting manual.
Product data sheets and manuals are available on the Emerson website at Emerson.com.

Return policy
Follow Emerson procedures when returning equipment.
These procedures ensure legal compliance with government transportation agencies and help provide a safe working
environment for Emerson employees. Emerson will not accept your returned equipment if you fail to follow Emerson
procedures. Return procedures and forms are available on our website at Emerson.com or by phoning the Emerson
Customer Service department.

Emerson Flow customer service
• Worldwide: flow.support@emerson.com
• Asia-Pacific: APflow.support@emerson.com
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1  Routine Maintenance
1.1  Meter maintenance

This section includes discussion of the maintenance of Rosemount™ 3812 Series Ultrasonic
Meters.
For reference, you may download the MeterLink™ Quick Start Manual.

 CAUTION
SURFACE TEMPERATURE HAZARD
Meter body and piping may be extremely hot or cold.
Wear appropriate personal protective equipment when coming in contact with the meter.
Failure to comply may result in injury.

 CAUTION
TRANSPORTATION HAZARD
When moving the meter, do not insert the forks of a forklift into the bore.
Inserting the forks may cause the meter to become unstable, resulting in injury to
personnel or damage to the bore and sealing face.

 WARNING
CRUSHING HAZARD
During meter installation or removal, always place the unit on a stable platform or surface
that supports its assembled weight.
Failure to comply can cause the meter to roll, resulting in serious injury or equipment
damage.

 CAUTION
TRIPPING HAZARD
Clear all obstacles or obstructions from the work area when transporting, installing or
removing the meter.
Failure to comply may cause injury to personnel.

 CAUTION
ESCAPING FLUIDS HAZARD
The purchaser of the meter is responsible for the selection of Emerson components/seals
and materials compatible with the chemical properties of the measurement fluid.
Failure to select suitable meter components/seals may cause escaping fluids, resulting in
injury to personnel or equipment damage.

Consult your Emerson Sales and Service representative to ensure you purchase the correct
components and seals for your application, below safety message.
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1.2  Field hydrostatic pressure testing procedures
The Rosemount™ 3812 Liquid Ultrasonic Flow Meter can be field hydrostatic tested without
any special preparations or disassembly. The transducers are not exposed to the process
pressure and can remain installed in the meter.
The liquid ultrasonic meter pressure containing parts include, but are not limited to
the transducer housings. The hydrostatic test is verification of the pressure containing
capability of the liquid ultrasonic meter pressure containing parts and seals. Each
Rosemount Liquid Ultrasonic Flow Meter is successfully hydrostatic pressure tested prior to
shipping from the factory.
The maximum field hydrostatic pressure test must be limited to 1.5 times the stamped
maximum working pressure. The maximum working pressure is stamped on the meter ID
tag.

 CAUTION
LEAKAGE OR PRESSURE CONTAINING PARTS FAILURE
Use precautions to eliminate hazards to personnel in the event of leakage or failure of the
liquid ultrasonic meter pressure containing parts or failure of the test equipment and to
prevent over-pressurization during the test procedure.
Failure to comply may result in injury to personnel or cause damage to the equipment.

NOTICE
A copy of this test is available by contacting Emerson Customer Support. Please provide the
body serial number when requesting a copy of the test report. The body serial number is
located on the downstream flange to the left of the hoist ring hole (when looking at the
flange face).
Emerson Customer Support contact information is located on the front page of the
manual.

1.3  Routine maintenance
Routine maintenance operations requires adherence to all applicable regulations and laws
and safety training for personnel to perform the maintenance operations. Review your
organization’s best practices procedures before performing routine maintenance.

1.3.1  Maintenance logs and reports
To monitor the performance health of the meter, and ensure it is operating
within acceptable specifications, routine diagnostics should be performed. Collecting a
maintenance log gives you a snapshot of the current health of the meter and you
can compare the inspection reports from previously saved logs. Go to Logs/Reports → 
Maintenance Logs and Reports. MeterLink displays the Maintenance Logs and Reports
dialog. Choose the time duration, log format and collection rate for the output file and click
the Start button. You can open the file immediately after it is generated or view it at a later
time. It is recommended that a maintenance log be collected after an upset in the system.
In establishing a baseline to be used for the trending of the meter diagnostics, it is very
helpful if a set of log files are collected immediately after the meter has been installed in
the field. Preferably, collect the log files at several velocities within the operating range of
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the meter. This helps establish that the flow profile is relatively constant throughout the
meters operating range (except velocities below 3 ft where the profile may vary).
Maintenance log collection

Figure 1-1: Maintenance log collection parameters

Trend maintenance log collection
Merging the results of two or more maintenance logs into a single file, allows you to build
a historical database of the meter’s performance. Trending the logs indicates changes from
the original installation of the meter, or over time. Looking at a single inspection report,
that is either collected monthly or quarterly, can give you an indication of the meter's
health.
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Figure 1-2: Trend log collection

This is important since many diagnostics change slowly over time. Trending the
maintenance logs helps identify these changes and makes problems much more obvious
than merely viewing a single inspection report. The trending feature is integral to
MeterLink which allows all important parameters to be trended. MeterLink supports
trending files in a Microsoft® Excel® workbook from multiple 3812 meter maintenance logs.
Some parameters like gain, signal level, and noise level may show a shift over time which
can be useful in detecting changes in the meter and the installation.
Maintenance logs or trend files to be trended must all have matching column headings.
This means the logs must be in the same units (i.e. U.S. Customary or Metric), must have
the same pressure type (i.e. gauge or absolute), and must have the same time base (1/
second, 1/minute, 1/hour, 1/day). If not, an error message will be displayed stating the
column headings do not match and the file will not be added to the Workbook to trend list.
Archive log collection
Archive logs that may be collected and the options include:
• Daily log - generated every 24 hours on the contract hour
• Hourly log - generated every hour at the top of the hour
• Event log - collects the alarm and event log records

Routine Maintenance Maintenance and Troubleshooting Manual
November 2023  00809-0100-3812

8 Emerson.com/Rosemount



Figure 1-3: Archive log collection parameters

The logs may be collected in a single file or you can choose to collect one type of log. Each
of the Meter Archive logs include the Meter Configuration file.

Maintenance and Troubleshooting Manual Routine Maintenance
00809-0100-3812 November 2023

Rosemount 3812 Liquid Ultrasonic Flow Meter 9



1.3.2  Pipeline cleaning maintenance
 WARNING

BURST HAZARD
Before pipeline cleaning and maintenance (“pigging operations”), remove straightening
vanes or flow conditioners.
Failure to comply can cause excessive pressure in the meter system, resulting in death,
serious injury or equipment damage.

Figure 1-4: 3812 Ultrasonic Flow Meter with flow conditioner for unidirectional flow

A. Flow
B. Flow conditioner straightening device

Figure 1-5: 3812 Ultrasonic Flow Meter with flow conditioner for bidirectional flow

A. Flow
B. Flow conditioner straightening device

Straightening vanes or flow conditioners must be removed during pipeline cleaning
maintenance operations (“pigging operation”). If the meter run is pigged with a flow
conditioner in line, pressure may build up and cause the pipes and flanges to burst and
severely injure personnel.
Important
The excessive pressure may damage the meter or the transducer ports may collect debris
which may impede data acquisition and flow measurement.
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Plugging hazard
Pipeline cleaning and maintenance (“pigging operations”) through the ultrasonic meter is
not recommended. The transducer ports may become plugged with debris and adversely
affect the transducer’s signal strength.
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2  Troubleshooting
2.1  Meter status alarms

Run MeterLink™ and open the Meter Monitor (Summary) view to perform a diagnostics
health check.

Figure 2-1: Meter Monitor (Summary) view

If the meter is measuring flow and operating within the calibration parameters the Meter
Status LED is green. If the Meter Status LED is red, an active alarm exists that requires
you to take corrective action. Click the Check Status button to display the Status Summary
screen. The alarms are shown with the primary causes listed first. Click the question mark,

, next to the alarm to display a help topic related to the alarm and recommended actions
to resolve the issue.

Figure 2-2: Status Summary
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2.1.1  Check status
Click the Check Status button if any of the LEDs are yellow or red to see more specific
information causing the status alarm. Some alarms do not require an acknowledgement
and will clear automatically when the alarm condition goes away. Alarms that require a
user to acknowledge them will have a button to the right titled ACK. Clicking the ACK
button changes the button text to Wait and sends a request to the meter to clear the
alarm. The alarm will disappear from the Check Status dialog once the alarm actually
clears.
Click the Check Status button and MeterLink™ opens the Status Summary dialog box that
gives a short description of all alarms present.

Figure 2-3: Meter Monitor Status Summary

A. Active alarm conditions from Meter Monitor page
B. Status Summary page with alarm examples

Following is a list and a brief description of the types of alarms:
• System
• Field I/O
• Validity
• Comms
• Check Status

2.1.2  System alarm
The System alarm indicates a failure in the hardware that should be addressed by a service
technician. This includes memory checksum errors and communication errors within the
hardware. A Red LED indicates a System alarm condition. Collect a maintenance log and an
audit/alarm log and then, contact your Emerson Flow service representative.

2.1.3  Chord A and Chord B alarm
Chord A and Chord B - These alarms indicate how a chord is functioning.

Troubleshooting Maintenance and Troubleshooting Manual
November 2023  00809-0100-3812

14 Emerson.com/Rosemount



LED Color Problem
Green No alarms are present. Chord is operating properly.
Yellow At least one sample in the batch caused an alarm but it did not

cause the chord to fail. The sample will not be used in the batch.
Discarding occasional samples can occur during normal operation
such as during flow velocity changes.

Red The chord has failed or is in acquisition. This chord is not used for
this batch. Chords that have failed or are shown to be in acquisition
for repeated batches indicates that the meter should be inspected
by a service technician.

Gray The chord has manually been set to inactive, or option is not
available.

2.1.4  Field I/O alarm
Reports various field I/O devices that are in alarm. Click the Check Status button for more
details on specific alarms. The field does not appear if the meter does not support this
alarm.

2.1.5  Validity alarm
This alarm indicates that the meter may not be measuring accurately. Click Check Status to
see a description of which validity alarms are active. The validity alarms QMeter and QFlow
indicate an issue with the meter, collecting enough information from the chords to make
an accurate measurement. The validity alarms for pressure and temperature indicate that
the value is above or below the alarm limits for these values. Red and green are the only
colors used for this alarm.

2.1.6  Comms alarm
The Comms alarm indicates that communications between MeterLink™ and the meter
failed. This could be due to a poor communication link. MeterLink continues to retry
communications. Red and green are the only colors used for this alarm.

2.1.7  Communications
The Communications Analyzer (via MeterLink™ Tools → Menu → Communications Analyzer
menu path) displays communications between MeterLink and the ultrasonic meter. This
utility is useful for troubleshooting communications to the meter. It displays many of the
TCP/IP commands between MeterLink and the connected meter.

2.2  Troubleshooting the meter
The following sections show errors that may occur with the meter hardware, firmware or
connections and recommended actions to resolve the problem(s).
Error
Acquisition Module Error
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Recommended actions
1. Check interconnect cable between Acquisition Module and the CPU Module.
2. Attempt the Program Download procedure to install the firmware.

a) Cycle power to the meter.
b) Replace the Acquisition Module (see Replace the Acquisition Module for 

direct or remote mount electronics).
c) If the Acquisition Module cannot be reprogrammed, collect a complete 

Archive log and contact your local area Emerson Flow service 
representative.

Error
Acquisition Module is not compatible with firmware

Recommended actions
1. Upgrade the firmware in the meter to the latest version using MeterLink™.

Contact your Emerson Flow service representative to obtain the latest firmware.
2. Replace the Acquisition Module.

Error
Chord failure

Recommended actions
Chord is hard failed (Chord A or Chord B) and meter is unable to obtain measurement data
from this pair of transducers.

1. If Chord A (or Chord B) is failed and no other transducers are failed or
are reporting status alerts, the issue is most likely isolated to this pair
of transducers or its cabling. Check the transducer wiring for this pair of
transducers to make sure connections are secure and wired correctly.

2. Verify that the meter run is not partially full where the top transducer pair
(Chord A) is not submerged in the process fluid.

3. Verify the average gain of this transducer pair is not above 90 dB. The gain
value can be read in MeterLink on the Monitor page.

4. Check the Acquisition Module transducer wiring for this pair of transducers to
make sure connections are secure and wired correctly.

5. If transducer cabling allows, swap cabling of failed transducer pair with a pair
with equal path lengths (Chord A1 and B1, Chord A2 and B2) or access the
acquisition module and swap the cabling of the failed transducer pair with a
pair with equal path lengths. If the alarm remains active for this chord, then the
transducers are working properly. If this alarm clears but the chord that was
swapped now fails, the issue is with the transducer.

6. Collect a Maintenance Log, Configuration file and Waveform stream file with
MeterLink and contact your Emerson Flow service representative.

Error
CPU Module LINK LED

Recommended actions
1. When connecting directly:

a) Use a cross-over cable connection (P/N 2-3-3400-079).
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2. When using a hub:
a) Use straight-through patch cable between the meter and the hub and a

straight-through patch cable between the hub and the PC.
b) Do not connect either the meter or PC to the hub UPLINK port.
c) Check the CPU Module LED1 is on (either solid red or flashing green). If

the LED is not on, check power to the meter.
d) If the LED is on, check the Ethernet cable connections.

Error
CPU Module LINK LED is on but I can't communicate with the meter using Ethernet

Recommended actions
If you are connecting for the first time:

1. Enable the DHCP switch on the CPU Module.
2. Verify that the PC has received an IP address from the meter as follows:

a) Bring up DOS prompt window (Start → Run-(type) cmd)
b) In the DOS prompt window, type ipconfig

3. If you get the following: IP 192.168.135.35 (note the last .35 can be up to .44)
with a Subnet Mask of 255.255.255.0 and Default Gateway you should be able to
connect to the meter.

4. If you get the following:
a) Ethernet adapter Local Area Connection 1

IP Address: 0.0.0.0

b) The PC has not yet received an IP address from the DHCP server wait (up
to 30 seconds) to receive an IP address before attempting to connect to
the meter.

c) After 30 seconds the PC has not received an IP address from the DHCP
server or the IP address shown above (from ipconfig) is different from
the range of 192.168.135.35 through 192.168.135.44, verify that the PC is
configured to receive its IP address automatically (via DHCP).

Error
Communication line connected to the flow computer but no signal is received

Recommended actions
1. Check for loose connections at the flow meter and the flow computer.
2. Check the CPU Module settings.

Error
Communicating with meter but all chords display failures

Recommended actions
1. Verify that the resistance of transducers is within specification (2 MΩ).
2. Check the Acquisition Module.
3. Check the interconnect cables between the Base Enclosure and the Transmitter

Electronics Enclosure.
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Error
Cannot communicate with MeterLink program

Recommended actions
1. Ensure that the meter is properly powered.
2. Ensure that the computer cable is properly connected and check your interface

pins (RS-485 or RS-232).
3. Verify that the communication parameters of the MeterLink program are

correctly set.
4. Check RS-485 or RS-232 communication.

Error
Cannot communicate with Field Communicator

Recommended actions
Refer to the AMS Trex Field Communication User’s
Manual, Rev D. This manual may be downloaded
from the following location: https://www.emerson.com/en-us/automation/
asset-performance-management/field-device-management/field-communicators/ams-
trex-device-communicator.
Note
The 375 or 475 field communicators are now obsolete and replaced with AMS Trex field
communicator.

Error
Cannot communicate with AMS Device Manager

Recommended actions
Refer to the AMS help documentation and support at the following
website: www.emerson.com/en-us/catalog/automation-solutions/asset-reliability/ams-
ams-device-manager.

Error
Connect to multiple meters via Ethernet when they are on the same LAN

Recommended actions
1. Configure each meter with a unique user-specified IP address.
2. Contact your IT department for valid IP addresses for your LAN and Gateway

addresses.
3. Disable the DHCP server.

Error
Connect to multiple meters via Ethernet when they are on the same hub but not connected
to an intranet LAN

Recommended actions
1. Configure each meter with a unique user-specified IP address.
2. Assign each meter on the hub a unique IP address within the range

192.168.135.150 through 192.168.135.254 (Gateway address for each meter
may be left unconfigured as 0.0.0.0).
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3. A PC may receive its IP address from an external DHCP server; in this case, one
and only one meter must have its DHCP server enabled (the DHCP server will
serve up to 10 IP addresses to PCs attempting to talk to all meters on the hub).

4. Once a meter's IP address is configured, the meter may be connected to the
hub and accessed using that IP address.

Error
Configuration changed

Recommended actions
One or more parameters have been modified in the meter's configuration.

1. Collect an Audit log using MeterLink in order to see what configuration
parameters changed and when they changed.

2. Run the Tools → Edit/Compare Configuration utility and click the Write All
button or select the check box in the value column and click Write Checked
button to write the changes to the meter.

3. Save the configuration file.
Error
Configuration lost

Recommended actions
The meter configuration has reset to default values and the meter is not configured
correctly to measure flow and the meter has performed a Cold Start.

1. Unless the Cold Start occurred after upgrading firmware, replace the CPU 
Module (see Replace the CPU Module).

2. If the cold start occurred after a firmware upgrade, fully re-configure the meter 
from a previously saved configuration using the Tools → Edit/Compare 
Configuration in MeterLink. For Rosemount™ Series 3810 Firmware v1.60 and 
later, the user database must be either imported from a saved user database 
using Meter → Manage Users dialog box or manually reentered using the same 
dialog box.

Error
Electronics temperature is out of nominal range

Recommended actions
Temperature of the electronics is out of nominal operating range -40 °F or above 212 °F
(below -40 °C or above 100 °C) which could lead to a system failure.

1. Attempt to warm or cool the meter electronics housing.
2. If the electronics is mounted to the meter and the process fluid in the meter

is over 149 °F (65 °C), you must remote mount the electronics off of the meter
body.

3. Collect a Maintenance log using MeterLink while the meter is experiencing the
issue and contact your Emerson Flow service representative.

Error
Flow pressure is outside the alarm limits

Recommended actions
1. Start up issues:
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a) Verify that there is voltage to the pressure sensor from either the meter's
power supply board or from an external power supply.

b) If using an analog pressure device, verify that the pressure sensor is
properly wired to the connector.

c) Verify the input is properly configured for your pressure input.
d) If using a flow computer to write pressure to the meter, verify that it is

properly writing to fixed flow pressure in the proper units.

2. Run time issues:
a) If using an analog pressure device and input reading is 0, check if

IsAI2Avail is equal to 1 in the Meter Information dialog in MeterLink. If it
is not 1, either the I/O Board has been removed or is damaged. Reinstall
or replace the CPU Module if this value is 0.

b) If using an analog pressure device, verify that the pressure sensor is
working properly.

c) If using an analog pressure device, recheck wiring and switch settings.
d) If a flow computer is writing values to the fixed flow pressure, verify

that the flow computer is still writing valid values without Modbus® write
errors.

e) Re-verify the pressure input settings are correct.

Error
Flow temperature is outside the alarm limits

Recommended actions
1. Start up issues:

a) Verify that there is voltage to the temperature sensor from either the
meter's power supply board or from an external power supply.

b) If using an analog temperature device, verify that the temperature
sensor is properly wired to the connector.

c) Verify the input is properly configured for your temperature input.
d) If using a flow computer to write temperature to the meter, verify that it

is properly writing to fixed flow temperature in the proper units.

2. Run time issues:
a) If using an analog temperature device and input reading is 0, check if

IsAI2Avail is equal to 1 in the Meter Information dialog in MeterLink. If it
is not 1, either the I/O Board has been removed or is damaged. Reinstall
or replace the CPU Module if this value is 0.

b) If using an analog temperature device, verify that the pressure sensor is
working properly.

c) If using an analog temperature device, recheck wiring and switch
settings.

d) If a flow computer is writing values to the fixed flow temperature, verify
that the flow computer is still writing valid values without Modbus write
errors.
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e) Re-verify the temperature input settings are correct.

Error
Program download failed during firmware upgrade

Recommended actions
If a meter experiences a power loss in the middle of a firmware upgrade, the meter
may become unresponsive and communications to the meter may not be possible. If
this occurs, contact Emerson Flow Support for assistance.

Error
No power to the unit

Recommended actions
1. Check that the correct voltage level is in the range of 11-36 VDC at the meter 

(refer to the System Wiring Diagram in Engineering drawings).
2. Check the main power source for blown fuse or tripped circuit breaker (see 

Replace the fuse). Reference your “as built” installation drawings for your 
location.

Error
One or more of the chords is not indicating a reading (reporting zeros)

Recommended actions
1. Check for loose connections at the cable connectors.
2. Check the resistance of the transducers (should be approximately 2 MΩ).
3. Problem also may be caused by a bad Acquisition Board or interconnect cable.
4. Check system status in the MeterLink program for any flagged errors.
5. Check the CPU Module.
6. If Chord A is not indicating, change the transducer cables from Chord B to chord

A. If Chord B then fails, the transducers are bad on Chord A.
Error
Power failure

Recommended actions
Meter has had power removed for a period of time or the meter restarted itself such as
after a firmware upgrade. The Audit log in the meter indicates the power fail time.

1. If this was an unexpected restart of the meter, verify the integrity of the power
to the meter and make sure that the voltage level is the in the range of 11-36
VDC at the meter.

2. If this was a known power fail or restart of the meter, just acknowledge this
alarm.

Error
Sound velocity is outside defined limits

Recommended actions
The meter's measured average sound velocity is outside the defined limits.

1. Verify that all chords are measuring the same speed of sound within about
0.15%. Look for alarms that indicate transducer problems and resolve any
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of these issues. This could include failing transducers, debris buildup on
transducers, or incorrectly entered path lengths in the configuration.

2. If the chords agree, adjust the SSMin or SSMax using the Field Setup Wizard
in MeterLink so the meter's average speed of sound falls within these limits
(consult with an Emerson Flow service representative before changing these
parameters).

3. Collect a Maintenance log using MeterLink and contact your Emerson Flow
service representative.

Error
Waveform contains an excessive amount of noise

Recommended actions
Use the MeterLink Meter → Signal Analyzer to increase the StackSize until noise level
decreases (settings can be 1 (none) 2, 4, 8, or 16). If increasing the StackSize is not
successful, try turning on the filter or consult with Emerson Customer Support if you
are unsure of how stacking a signal can affect the meter's operation.

2.2.1  Meter monitoring maintenance
Run MeterLink™ and open the Meter Monitor (Summary) to view the current health status
of your meter.
The Monitor (Summary) includes the direction of flow measurement, velocity rate, units
of measurement, uncorrected flow and a bar graph for a visual comparison between the
velocities for each chord.

Figure 2-4: Meter Monitor (Summary) view

Refer to Troubleshooting the meter for error resolutions and Table 2-1 for meter
maintenance hardware diagnostics.
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Table 2-1: Maintenance
MeterLink utility Diagnostics Action(s)
Meter Monitor (Summary) view Check Status for active alarms • Meter Status LED is green if there are no

active alarms. This indicates the meter is
measuring flow and operating within the
calibrated parameters.

• Meter Status LED is red. This indicates
an active alarm. Resolve and acknowledge
active alarms as displayed on the Status
Summary page. Click the Help button,

, beside the alarm description to
display information about the alarm and
recommended actions to resolve the issue.

Meter Monitor (Detailed) view Flow Profile • Flow profile velocity for Chords A and B
shown on the bar graph should be of equal
lengths and at 3 ft/s should be 1.0 (range
of 0.95 to 1.05 indicates a good flow profile
velocity).

• If the velocity ratio is greater than a 10%
differential between chords, a degradation
in the symmetry is indicated.

• Check for a chord failure and resolve this
and clear the alarm.

• If installed, check the flow conditioner for
blockage.

• Compare gains and Signal to Noise (SNR)
ratios decibel values with the meter
calibration values in the Maintenance log
Inspection report.

• The meter may not be in measurement
mode or there are too few operating chords.

• Check chord average signal amplitudes
with the meter baseline values in the
Maintenance log Inspection report.

Meter Monitor (Summary) view
Meter Flow Properties Table

Flow velocity • Check the flow direction. If reverse flow is
detected, check for valve leaks.

• If the meter run typically has reverse flow
when flow is stopped, use the Field Setup
Wizard → General Page and reconfigure
the ReverseFlowVolLmt to allow a higher
volume.

Meter Monitor (Detailed) view
Monitor Chart Selection list

Speed of Sound • Compare Speed of Sound deviation from
measured SOS relative to the average SOS.

• Check the chord’s SOS.
• Check and correct geometry configuration

(pipe diameter, distance between the
transducers (LA), and delay time).

• If present, resolve transducer issues (failed
transducer, cabling or debris buildup on the
transducer face, or path length configured
incorrectly).
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Table 2-1: Maintenance (continued)
MeterLink utility Diagnostics Action(s)

• Adjust SSMin or SSMax (consult a Emerson
Flow service representative before making
these adjustments).

Meter Monitor (Detailed) view
Meter Data List

Electronics temperature out of
range

Temperature of the electronics is out of nominal
operating range below -40 °C or above 100°C
(-40 °F or above 212 °F).
• Heat or cool the meter electronics housing.

If operating temperature exceeds 65 °C,
remote mount the Transmitter Electronics
Enclosure.

Meter Monitor (Detailed) view
Meter Data List

Electronics voltage out of
range

• CPU board system voltages are valid if 1.0 V,
1.2 V, 2.5 V, 3.3 V or the Acquisition Module
valid voltages are 1.2 V, 2.5 V or 3.3 V.

• Replace the CPU Module if one or more of
the system voltages is out of range.

• Replace the Acquisition Module if one or
more of the voltages is out of range.
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Table 2-1: Maintenance (continued)
MeterLink utility Diagnostics Action(s)
MeterLink Tools Menu Frequency output • Run the Frequency Outputs test.

• If the output reads zero, you may require a
pull up resistor 1.2k OHM, 0.5 W.

• Check frequency output from minimum to
maximum values.

MeterLink Tools Menu Analog outputs Run Analog Outputs test and verify outputs are
within 4 mA -20 mA range
• 0% = 4 mA
• 25% = 8 mA
• 50% = 12 mA
• 75% = 16 mA
• 100% = 20 mA

MeterLink Tools Menu Digital outputs • Run Digital Outputs test.
• Digital output content is in relation

to frequency validity and flow direction
configuration and polarity.

Meter electronics Acquisition Module
communications error

• If the CPU Module LED 5 is not flashing
green, check interconnect cable between
Acquisition Module and the CPU Module.

• Check firmware revision and upgrade if
necessary using MeterLink Tools → Program
Download.

• If the CPU Board LED 5 is not flashing green,
replace Acquisition Module (see Replace the
Acquisition Module for direct or remote
mount electronics).
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Table 2-1: Maintenance (continued)
MeterLink utility Diagnostics Action(s)

MeterLink Logs/Reports Menu Meter performed a warm start
or a warm start is required

• Meter performed a warm start:
— Collect an Archive event log (Audit log)

using MeterLink to view configuration
parameters changes and when they
changed.

• Warm start required:
— When you make changes to the

transducer characteristics, sample rates,
the device number, or a Modbus map
file.
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Table 2-1: Maintenance (continued)
MeterLink utility Diagnostics Action(s)
MeterLink Tools → Edit/
Compare Configuration Menu

Meter performed a cold start • The meter configuration has reset to default
values and the meter is not configured
correctly to measure flow.

• Unless the cold start occurred after
upgrading firmware, you may need to
replace the CPU Module.

• If the cold start occurred after a firmware
upgrade, you must reconfigure the meter
from a previously saved configuration
file using the Edit/Compare Configuration
screen. For Rosemount™ Series 3810
Firmware v1.60 and later, the user database
must be either imported from a saved
user database using Meter → Manage Users
dialog box or manually reentered using the
same dialog box. Then clear the latched
alarm on the Status Summary page.

MeterLink Logs/Reports Menu Power failure • If this was a known power fail or restart of
the meter just acknowledge this alarm on
the Status Summary page.

• If this was an unexpected restart of the
meter, verify the integrity of the power to
the meter and make sure that the voltage
level is in the range of 11-36 VDC at the
meter.

• Collect an Archive event log (Audit log) using
MeterLink.

MeterLink Meter Monitor
(Summary) view

Chord Failure • The meter is unable to obtain measurement
data from a pair of transducers.

• The cause may be isolated to one pair
of transducers or its cabling. Check the
transducer wiring for this pair of transducers
to make sure connections are secure and
wired correctly.

• Verify that the meter run is not partially
full where this top transducer pair is not
submerged in the process fluid.

• Verify the average gain of this transducer
pair is not above 90 dB. Read the value from
the MeterLink Monitor page or using AMS
under Service Tools → Path performance.

• Remove the transducer and clean the
transducer face. Reapply coupling fluid
to the transducer face and reinstall (see
Transducers replacement).
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Table 2-1: Maintenance (continued)
MeterLink utility Diagnostics Action(s)
Security seals • End cap seals

• End caps latches
• Transmitter Electronics

Enclosure
• Base Enclosure
• Shroud seals

Only authorized personnel may remove security
seals. Follow your standard operating procedure
to report seals that have been tampered
with or removed and replace the seals per
instructions in Section 3.6.8 in the Installation
Manual (00825-0100-3812).

External ground wiring Transmitter Electronics
Enclosure ground lug

Inspect ground lug wiring and make sure the
wiring is tightly secured.

Conduit seals Transmitter Electronics
Enclosure

• Inspect the conduit sealant and follow your
standard operating procedure to report
tampering with the conduit sealant.

• Your operating procedures may require a
certified electrician and company witness to
reseal the conduit.

Flanges Inspect for leaks Perform leak tests on flanges

2.2.2  Unable to connect direct serial or external serial modem
Ensure that you do not have more than one modem driver installed to the same COM
port. Typically this will only be necessary if you use one COM port to talk direct (serial
communications) and use the same COM port to connect to an external modem. This
is an apparent limitation in Microsoft’s® Dial-up Networking. If more than one modem
driver is installed for a particular COM port, Dial-up Networking will always use the last
driver installed regardless of what is selected. The only work around is to only install one
modem driver per COM port on the PC at a time. Refer to the MeterLink Quick Start Manual
(00809-0100-7630) for phone and modem details.

2.2.3  Unable to connect to meter
If you receive the error message “Unable to connect to meter” when trying to connect to a
Rosemount™ Liquid Ultrasonic Flow Meter, refer to the following:
• Ethernet connections
• Direct serial connections

2.2.4  Ethernet connections
If you received the error message "Unable to connect to meter" while trying to connect
over Ethernet, verify you have the correct IP address in the Meter Directory record. If
the meter is to assign the IP address, make sure the IP address is set to 192.168.135.100
and that the DHCP switch is ON position on the CPU Module. If the meter has a fixed
IP address, verify the IP address, Subnet, and Gateway are correct in the meter. Verify
your wiring to make sure you have a cross-over cable for a direct connection between the
meter and the computer. If going through a hub, verify that the computer and meter are
connected to the hub with straight-through patch cables.
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2.2.5  Direct serial connections
Verify the switch settings on the CPU Module. Also verify your wiring between the meter
and the computer running MeterLink™ using the Field Wiring drawing DMC-004946. Verify
the Comms Address and Baud rate are correct in the Meter Directory record. If unsure of
the port settings for Port A on the CPU module, you can change the PORT A switch on
the CPU module from OFF to ON and the port will be forced to RS-232, 19200 baud rate,
Modbus ID=32 for two minutes.
For additional information on wiring and configuring the meter for the various
communication options, refer to the Installation manual (00825-0100-3812).

2.3  Troubleshoot maintenance log files and trend
files

2.3.1  Files do not appear in workbook
Maintenance Log files and Trend files that exist on the PC do not appear in the Microsoft®

Excel® workbooks tree under Trend Maintenance Logs.
This is most likely caused by the fact that the desired file or files are already open in
Microsoft Excel. Open files can not be verified as Maintenance Log files or Trend Files by
MeterLink and are left out of the list. Simply close the files in Microsoft Excel and then close
and reopen the Trend Maintenance Logs dialog box to include them in the list.

2.3.2  Microsoft® Excel® Log/Export options are not available
In order for the Excel log/export options to be available, Excel must be installed on the
machine and at least one printer must be installed under the Windows operating system.
If Excel is installed and you have printers installed but the Excel option is still unavailable, it
may be because Excel cannot access the printer driver information of the Windows default
printer. If the Windows default printer is a network printer and you are not currently
connected to the network, then Excel will most likely not be able to access the printer
driver information and MeterLink™ cannot use Excel to generate reports or logs.
One solution is to install a local printer on your machine tied to LPT1. The local printer
driver you installed can be for any printer and the printer does not actually have to exist
or be connected to the PC. If you install a local printer, you can configure MeterLink to
temporarily change your Windows default printer over to this local printer while running
MeterLink. Do this by selecting this local printer for the Override system default printer
selection in the Program Settings dialog. MeterLink will automatically change the Windows
default printer to the selected override printer when it starts and will set the Windows
default printer back to its original printer when it closes.

2.3.3  Maintenance Logs or Trend files are not created
Prerequisites
When using Excel®, some of the worksheets in the Maintenance Logs or Trend files are not
created.
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If the Inspection sheet of the Maintenance Log file or the Charts sheet of a Trend files is
not generated, it is probably because Excel is not configured to allow MeterLink™ to run the
Visual Basic® script that generates the page. Excel can be configured to allow MeterLink to
run the Visual Basic script by following the instructions below.
To enable Excel to work with MeterLink, select Options under the File menu. Under the
Trust Center tab, click Trust Center Settings. Under the Macro Settings tab, select Trust
access to the VBA project object model.

2.4  Meter reset mode
For Rosemount™ Series 3810 Firmware v1.60 and later, the meter supports a reset mode to
configure the meter back to default conditions.
There are two supported modes: Reset users and Cold start meter. Reset users will delete
all users in the user database and restore the factory default administrator username
and password. Cold start meter will return the entire meter configuration back to default
settings, clear all logs, delete all users in the user database, and restore the factory default
administrator username and password.
Prerequisites
• The default password is Administrator-XXXXX where XXXXX is the non-zero padded

central processing unit (CPU) serial number which can be found on a label on the CPU
module.

• Before proceeding, if you can still connect to the meter, it is recommended that you
collect the meter configuration using the Edit  → Compare Configuration screen and
export the user database using the Meter → Manage Users dialog box.

• The WRITE PROT switch must be off in order to cold start the meter. The users can be
reset with the switch on or off.

Procedure
1. Connect your computer with MeterLink™ to the meter that requires a reset using the

appropriate cable.
2. To put the meter in reset mode, transition the Port A Override switch on the CPU

module from the Off position to the On position three times within five seconds and
leave the switch in the On position after the third transition.
Tip
Use a retractable ballpoint pen with the ballpoint retracted as a tool to transition the
switch.
The meter will enter meter reset mode after five seconds and remain in meter
reset mode for up to two minutes or until a reset action is complete or the Port A
Override switch is moved to the Off position.

3. Within the two minutes, connect to the meter with MeterLink. A Meter Reset Mode is
enabled dialog box will appear.

4. Click the desired option to either Reset users or Cold start meter.
MeterLink will prompt you to confirm the operation. Once the operation is
confirmed, the meter will begin the selected reset operation. MeterLink will
disconnect from the meter once the operation has completed.

5. Connect to the meter again using the default administrator username and go to
Meter → Manage Users to set up new users and change the default password for
the administrator user.
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• For added security, the default username for the administrator user can be
changed as well.

• If a Cold start meter operation was performed, you must reconfigure the
meter from a previously saved configuration file using the Edit  → Compare
Configuration screen.
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3  Meter maintenance
3.1  General maintenance tasks

Rosemount™ 3812 Liquid Ultrasonic Flow Meters require minimal maintenance. The
Meter maintenance section discusses procedures to re-wet the transducers, replacing the
transducer housings or transducers, and the Transmitter Electronics.
Choose the section that details the specific meter (e.g. 2 - 3-in., 4 - 10-in., and 12-in. and
larger sizes) for direct or remote mount transmitter electronics with a bolted band shroud,
split shroud, band shroud or latched shroud.
Table 3-1: Contents-Transducer maintenance
Maintenance task Description Section
Remove the shroud • Band shrouds

• 2 -3-in. meters
• 12-in. and larger meters
• Split shroud
• Latched shrouds

• Remove the shrouds
• Remove bolted band shrouds
• Remove clamped band shrouds
• Remove split shrouds
• Remove latched band shrouds

Re-wet the transducers Common procedure for all
meters

• Re-wet the transducers

Replace the transducer
housing

Common procedure for all
meters

• Replace transducer housing
and seals

Replace the transducers Replace the transducers
• Direct mount electronics
• Remote mount electronics

• Transducers replacement
• Replace transducers for direct

mount electronics
• Replace transducers remote

mount transmitter electronics

Replace the meter
electronics

Meter electronics
• CPU board
• Fuse
• Backplane board
• I.S. Barrier board
• Power Supply board
• Acquisition Module
• Acquisition cable

• Meter electronics replacement
• Replace the CPU Module
• Replace the fuse
• Replace the Backplane
• Replace the I.S. Barrier board
• Replace the Power Supply

Board
• Replace the Acquisition Module

for direct or remote mount
electronics

• Acquisition cable replacement
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Table 3-1: Contents-Transducer maintenance (continued)
Maintenance task Description Section
Install the shrouds • Band shroud options

• Bolted shroud (2 -3-in.
meters)

• Clamped shroud (12-in. and
larger)

• Split shroud (4 to 10-in.
meters)

• Latched shroud (2 to 10-in.
meters)

• Shrouds installation
• Install bolted band shrouds
• Install clamped band shrouds
• Install split shrouds
• Install latched band shroud

Seal the meter Seal the meter electronics and
transducers

• Seal direct or remote
mount transmitter electronics
enclosure

• Seal direct or remote
mount transmitter electronics
enclosure

• Seal direct or remote mount
Base electronics enclosure

3.2  Important safety information
Follow these safety message instructions to avoid injury and equipment damage.

 CAUTION
SURFACE TEMPERATURE HAZARD
Meter body and piping may be extremely hot or cold.
Wear appropriate personal protective equipment when coming in contact with the meter.
Failure to comply may result in injury.

 CAUTION
TRANSPORTATION HAZARD
When moving the meter, do not insert the forks of a forklift into the bore.
Inserting the forks may cause the meter to become unstable, resulting in injury to
personnel or damage to the bore and sealing face.

 CAUTION
TRIPPING HAZARD
Clear all obstacles or obstructions from the work area when transporting, installing or
removing the meter.
Failure to comply may cause injury to personnel.
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NOTICE
Prior to lifting the unit, refer to the Rosemount™ 3812 Liquid Ultrasonic Flow Meter
nameplate or outline dimensional (general arrangement) drawing for the assembled
weight.

 WARNING
FLUID CONTENTS MAY BE UNDER PRESSURE
When the meter is under pressure, DO NOT attempt to remove or adjust the transducer
housing.
Attempting to do so may release pressurized fluid, resulting in serious injury for personnel
or equipment damage.

 WARNING
FLUID CONTENTS MAY BE HAZARDOUS
The meter must be fully depressurized and drained before attempting to remove the
transducer housing. If fluid leaks at the joint of the transducer housing and the body as the
transducer housing is unscrewed, immediately reinstall it.
Failure to comply may cause serious injury to personnel or equipment damage.

A. Transducer housing and meter body joint

 CAUTION
ESCAPING FLUIDS HAZARD
The purchaser of the meter is responsible for the selection of Rosemount components/
seals and materials compatible with the chemical properties of the measurement fluid.
Failure to select suitable meter components/seals may cause escaping fluids, resulting in
injury or equipment damage.
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Consult your Emerson Sales and Service representative to ensure you purchase the correct
components and seals for your application.

3.3  3812 meter options
Figure 3-1: Direct mount transmitter electronics options

A. Bolted band shroud design - 2 and 3-in. sizes
B. Split shroud design 4 to 10-in. - 150 and 300 ANSI sizes
C. Latched shroud design 4 to 10-in. - 150 and 300 ANSI sizes
D. Clamped band shroud design - 12-in. and larger sizes
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Figure 3-2: Remote mount transmitter electronics options

A. Bolted band shroud design 2 and 3-in. sizes
B. Split shroud design 4 to 10-in. - 150 and 300 ANSI sizes
C. Clamped band shroud design 12-in. and larger sizes

Transducer field removal and installation is required if a transducer is fouled or if a chord
failure occurs.
The LT-10 and LT-11 transducers have a spring loaded assembly with the piezoelectric
element at one end and the transducer cable at the other end. Meters are supplied with
transducers which are extractable while the line is pressurized. The transducer assembly
shown below is a one-piece capsule that can be easily installed or removed from the meter
without depressurizing the unit using the tool list provided in Table 3-9.
• LT-10 transducers are designed for 2 through 10 inch meter sizes.
• LT-11 transducers are designed for 12 inch and larger meters sizes.
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Figure 3-3: LT-10 and LT-11 transducer assembly

A. Transducer cable (integral part of transducer capsule - Item F)
B. Feed-thru cable seal (LT-10 P/N 1-504-90-178) (LT-11 P/N 1-504-90-185)
C. Retaining ring (LT-10 P/N 1-504-08-009) (LT-11 P/N 1-504-08-007)
D. Shoulder washer (LT-10 P/N 1-504-90-181) (LT-11 P/N 1-504-90-183)
E. Spring (LT-10 P/N 1-504-90-046) (LT-11 P/N 1-504-90-047)
F. Transducer capsule and cable assembly (LT-10 P/N 1-360-01-624) or (LT-11 P/N

1-360-01-823)
G. O-ring (part numbers vary with service conditions)
H. Transducer housing:

• LT-10 (P/N 1-360-01-632 for 900 ANSI 316L SS or P/N 1-360-01-633 Inconel)

• LT-11 (P/N 1-360-01-819 for 900 ANSI 316L SS or P/N 1-360-01-818 Inconel)

3.4  Remove the shrouds

3.4.1  Remove bolted band shrouds
 WARNING

CUTTING HAZARD
Sharp edges may be present on the band shrouds.
Wear appropriate personal protective equipment when working on the meter.
Failure to comply may cause serious injury.
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Table 3-2: Band shroud removal tool list
Tools required
Standard ½-in. socket or a standard ½-in. wrench
Appropriate personal protective equipment

Figure 3-4: Bolted band shroud meter assembly - top view

A. Bolted band shroud

Figure 3-5: Bolted band shroud meter assembly - bottom view

A. 5/16-in. -18UNC bolts and lock washers

Procedure
1. Use the ½ wrench to loosen and remove one of the bolted band shroud bolts and

lock washer while holding the band shroud to prevent spring back of the shroud.
2. Loosen and remove the second bolted band shroud bolt with lock washer using the

½-in. wrench.
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3. Spread the band shroud apart and remove from the body and place the circular
edge on a flat surface.

4. Use the ½-in. wrench and remove the two end shroud bolts with lock washers while
holding the end shrouds in position. As the bolts are loosened, remove both end
shrouds and place on a flat surface.

5. Repeat Steps 1 through 4 to remove the other band shroud.
6. Move the shroud parts, bolts and lock washers out of your immediate work area.

This completes the bolted band shroud removal procedure.

3.4.2  Remove clamped band shrouds
 WARNING

CUTTING HAZARD
Sharp edges may be present on the band shrouds.
Wear appropriate personal protective equipment when working on the meter.
Failure to comply may cause serious injury.

Table 3-3: Clamped band shroud removal tool list
Tools required
Standard ½-in. socket or a standard ½-in. wrench
Flat blade screw driver or 5/16-in. nut driver
Appropriate personal protective equipment

Figure 3-6: Clamped band shroud meter assembly

A. Top end shroud
B. Front band shroud
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Figure 3-7: Clamped top end shroud assembly

A. Top end shroud
B. Top end shroud bolts

Procedure
1. Remove top end band shroud security seals, if installed.
2. Using a ½-in. wrench on one of the top end shroud bolts, rotate counterclockwise to

unscrew and remove. Repeat to remove the second bolt (see Figure 3-6).
3. Remove the top end shroud by pulling the part away from the Transmitter

Electronics Enclosure (see Figure 3-7).
4. Hold both ends of the clamped band shroud flat against the body OD. Using a flat

blade screw driver or 5/16 nut driver, loosen both worm screw clamp assemblies.
Alternate between the two worm screw clamp screws, turning each a few turns at a
time counterclockwise. Repeat as needed to fully disengage the threaded part of the
worm screw clamp from the screw part of the worm screw clamp and remove them
from the shroud.
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Figure 3-8: Clamped shroud worm screw disassembly

A. Worm screw clamp threaded part
B. Worm screw clamp screw part
C. Guide pin holes

5. While holding the shroud end engaged with the guide pins against the body OD,
raise the other shroud end edge enough to unlock the threaded part of the worm
screw clamp from the shroud. To remove the worm screw clamp threaded part,
move it to approximately perpendicular to the shroud and rotate slightly to release
the "T" end from the rectangular hole in the shroud. Repeat this procedure for the
second worm screw clamp threaded part.
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Figure 3-9: Clamped shroud worm screw parts

A. Worm screw threaded part
B. Worm screw - screw end
C. Clamped shroud “T” end and rectangular cutout
D. Clamped shroud guide pin holes

6. Now, hold the shroud end without the guide pins (back band shroud) close to
the body OD and raise the shroud end engaged with the guide pins enough to
disengage the band shroud from the guide pins. Remove the nut part of the worm
screw clamps following the same procedure described above.

Figure 3-10: Clamped band shroud disassembly

A. Back band shroud
B. Worm screw clamps
C. Guide pins
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7. Grasp both ends of the clamped band shroud and move them apart from each other
and move the edges towards the body center removing the band shroud from the
body OD. Place one edge of the band shroud assembly on a flat surface.

8. With the clamped band shroud assembly on its side edge on a flat surface, locate
the hem bend joint of the band shroud assembly half way from each end. Move each
part of the assembly away from each other, freeing the sheet metal hem bend joint.
Place the band shroud assembly on its side edge on a flat surface. Move the back
band shroud with respect to the front band shroud, freeing the sheet metal hem
bend joint assembly.

Figure 3-11: Band shroud hem bend joint

A. Front shroud hem joint
B. Back shroud hem joint

9. Repeat Step 1 to Step 8 to remove the other clamped band shroud parts.
10. Move all of the clamped band shroud parts, top end shrouds, bolts, lock washers,

and worm screw clamps out of your immediate work area.
This completes the clamped band shroud removal procedure.
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3.4.3  Remove split shrouds
 WARNING

SHARP EDGES - CUTTING HAZARD
Equipment may have sharp edges.
Wear safety approved gloves, eye protection, and shoes when disassembling the shrouds.
Failure to comply may cause serious injury.

Table 3-4: Split shroud removal tool list
Tools required
Standard 7/16-in. (11 mm) socket wrench or a standard 7/16-in. wrench
Appropriate personal protective equipment

Figure 3-12: Split shroud removal

A. Upper split shroud
B. Hex nuts with integral tooth lock washers and shroud clamps
C. Lower split shroud

Procedure
1. Using a 7/16-in. (11 mm) wrench, loosen and remove the four lower split shroud hex

nuts with integral tooth lock washers and shroud clamps (see Figure 3-12).
2. Remove the shroud clamps from each of the four studs by pulling the clamp off of

the ‘stud at each location.
3. Slide the lower split shroud down to remove it from the meter body.
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4. Move the shroud assembly and bolts out of your immediate work area.
This completes the split shroud removal procedure.

3.4.4  Remove latched band shrouds
The latched band shroud is utilized on 2 to 10-in. ultrasonic flow meters.

Figure 3-13: Latched band shroud removal

A. Band shroud
B. Stainless steel strike
C. Transducer cable
D. Pop rivet mandrel cutout
E. Meter body shoulder
F. Shroud latch

 CAUTION
SHARP EDGES - CUTTING HAZARD
Personal Protective Equipment Required
Band shrouds may have sharp edges. Wear safety approved gloves, eye protection, and
shoes when disassembling the shrouds to avoid potential injury.

Procedure
1. If installed, remove the security wires and shroud latch retainers.
2. Lift the one of the shroud latches and slowly disengage the latch from the strike.
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Figure 3-14: Shroud latch retainer

A. Shroud strike
B. Shroud latch
C. Shroud latch retainer

3. Carefully, lift the band shroud from the meter body (see Figure 3-13).
4. Move the shroud assembly and latches out of your immediate work area.
5. Repeat for the other latch.

This completes the latched single band shroud removal procedure.

3.5  Re-wet the transducers
This procedure applies to meters with direct mount or remote mount electronics
enclosures. If the chord signal quality diminishes, re-wet the transducers to improve the
signal strength.
Table 3-5: Transducer maintenance tools and shop supplies list
Tools required
Dow Corning Silicone 200(1) Oil
Retaining ring pliers (Rosemount™ P/N 1-504-90-043 or or Stanley Proto #J371 or #371L)
MeterLink, or AMS™ Device Manager or a Field Communicator

(1) Dow Corning 200 is a trademark of Dow Corning Corporation, U.S.A.

Procedure
1. Disassemble the shrouds. Refer to the appropriate sections below for your meter:

• Remove bolted band shrouds
• Remove clamped band shrouds
• Remove split shrouds
• Remove latched band shrouds

2. Use retaining ring pliers to pull the transducer feed-thru cable seal from the
transducer housing.
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Figure 3-15: Remove transducer from housing

A. Feed thru cable seal removal
B. Retaining ring pliers

3. Slide the feed-thru cable seal down the cable.

Figure 3-16: Feed-thru cable seal removal

A. Feed-thru cable seal

4. Use the retaining ring pliers and remove the retaining ring, shoulder washer, and
spring from the transducer housing.

5. Pull the transducer capsule from the housing.
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Figure 3-17: Transducer removal

A. Feed-thru cable seal
B. Shoulder washer
C. Spring
D. Transducer capsule

Figure 3-18: LT-10 Transducer and cable assembly removed from meter

6. Place one drop of Dow Corning 200 Silicon Oil(1) (12,500 Centistokes) (P/N
1-360-01-650) on the face of the transducer. Make sure the oil is evenly distributed
across the transducer face.

7. Wipe excess oil from the transducer sides.
8. Insert the re-wetted transducer capsule into the transducer housing inside the

meter body.

(1) Dow Corning 200 is a trademark of Dow Corning Corporation, U.S.A.
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9. Slide the spring and shoulder washer along the cable to the transducer capsule.
Install the retaining ring into the groove within the transducer housing while
compressing the spring by applying force to shoulder washer.

Figure 3-19: Reassemble transducer components

A. Feed thru cable seal
B. Retaining ring
C. Shoulder washer
D. Spring
E. Transducer capsule
F. Transducer housing

10. Slide the feed-thru cable seal along the cable towards the transducer housing. Insert
the feed thru cable seal into the housing groove with the retaining ring pliers.

11. Repeat Step 3 through Step 10 for re-wetting the other pair of transducers on the
meter.

12. Insert the feed-thru cable seal into the housing groove with the retaining ring pliers.
13. Apply electrical power to the meter.
14. Connect to the meter with MeterLink and run the Zero Flow Calibration Wizard.

Then, collect and save a Maintenance log to show the “as left” condition of the
meter. Or use AMS™ Device Manager or a HART® Field Communicator and select
Overview →  Zero Calibration → Start menu or Service Tools → Maintenance → Zero
Calibration → Start.

15. Reinstall the shroud. To do so, go to:
• Install bolted band shrouds
• Install clamped band shrouds
• Install split shrouds
• Install latched band shroud
This completes re-wetting the transducer procedure.
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3.6  Transducer housings or housing seals
replacement
If it is necessary to remove the transducer housings or housing seals, use the following
steps to safely remove and reinstall them. This procedure applies to meters with direct
mount or remote mount Transmitter Electronics Enclosures.

 WARNING
CUTTING HAZARD
Sharp edges may be present on the meter.
Wear appropriate personal protective equipment when working on the meter.
Failure to comply may cause serious injury.

 WARNING
FLUID CONTENTS MAY BE UNDER PRESSURE
When the meter is under pressure, DO NOT attempt to remove or adjust the transducer
housing.
Attempting to do so may release pressurized fluid, resulting in serious injury for personnel
or equipment damage.
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 WARNING
FLUID CONTENTS MAY BE HAZARDOUS
The meter must be fully depressurized and drained before attempting to remove the
transducer housing. If fluid leaks at the joint of the transducer housing and the body as the
transducer housing is unscrewed, immediately reinstall it.
Failure to comply may cause serious injury to personnel or equipment damage.

A. Transducer housing and meter body joint

Table 3-6: Transducer housing removal tool list
Tools required
For transducer housing removal - Crescent wrench, channel lock pliers wrench or socket. 2-in. thru
10-in. meter size 1-in. wrench. 12-in. and larger meter size 1.5-in. wrench.
7/15-in. wrench (11 mm)
Retaining ring pliers (Rosemount™ P/N 1-504-90-043 or Stanley Proto #J371 or #371L)
MeterLink, or AMS™ Device Manager or a HART® Field Communicator

3.6.1  Replace transducer housing and seals
Procedure

1. Disable electrical power to the meter.
2. Before removing the transducer housing, drain the meter of fluid and ensure the

pressure inside the meter is at atmospheric pressure. If fluid leaks at the joint
of the transducer housing and the body as the transducer housing is unscrewed,
immediately reinstall. The meter has not been drained and/or depressurized.

3. Disassemble the shrouds. Refer to the appropriate sections below for your meter:
• Remove bolted band shrouds
• Remove clamped band shrouds
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• Remove split shrouds
• Remove latched band shrouds

4. Use retaining ring pliers to pull the transducer feed-thru cable seal from the
transducer housing.

Figure 3-20: Remove transducer from housing

A. Feed-thru cable seal removal
B. Retaining ring pliers

5. Slide the feed-thru cable seal down the cable.

Figure 3-21: Feed thru cable seal removal

A. Feed thru cable seal

6. Use the Retaining Ring pliers and remove the retaining ring, shoulder washer, and
spring from the transducer housing.

7. Pull the transducer capsule from the housing.
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Figure 3-22: Transducer removal

A. Feed-thru cable seal
B. Shoulder washer
C. Spring
D. Transducer capsule

8. Using a wrench, socket or pliers on the hex of the transducer housing, carefully
unscrew the transducer housing from the meter body transducer port.
Important
If fluid leaks at the joint of the transducer housing and the body as the transducer
housing is unscrewed, immediately reinstall. The meter has not been drained
and/or depressurized. Repeat draining the fluids and depressurizing the meter, if
necessary.
Once assured all pressure is vented and fluid within the meter is drained, continue
to unscrew and remove the transducer housing from the meter body.

9. Prepare to install the a new transducer housing.
Note
Rosemount™ recommends replacing the O-ring seals each time the transducer
housing is replaced.

a) If replacing the O-ring seal, remove the used seal and discard. Apply Molykote
111(2) grease to the new seal and install on the transducer housing.

b) If replacing the transducer housing, discard the used transducer housing and
apply Molykote® 111(3) grease to the O-ring on the new transducer housing.

(2) Dow Corning Molykote® 111 is a trademark of Dow Corning Corporation, U.S.A.
(3) Dow Corning Molykote® 111 is a trademark of Dow Corning Corporation, U.S.A.
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c) Apply a light coat of Loctite® anti-seize nickel grade lubricant (20g stick-37230)
on the transducer housing threads.

10. Ensure the transducer housing threads are properly aligned (avoid cross-threading
the housing) with the meter body port hole threads. Use a wrench, socket or pliers
on the hex of the transducer housing and slowly turn in a clockwise direction. Once
the transducer housing is fully seated against the meter body, torque the transducer
housing as specified in the table below.
Transducer
housing

Torque
range ft-lb
(N-m)

Transducer housing

LT-10 40-43
(49-53)

LT-11 90-99
(122-134)

11. Place one drop of Dow Corning 200 Silicon Oil(4) (12,500 Centistokes) (P/N
1-360-01-650) on the face of the transducer. Make sure the oil is evenly distributed
across the transducer face.

12. Wipe excess oil from the transducer sides.
13. Insert the re-wetted transducer capsule into the transducer housing port inside the

meter body.
14. Slide the spring and shoulder washer along the cable to the transducer capsule.

Install the retaining ring into the groove within the transducer housing while
compressing the spring by applying force to shoulder washer.

(4) Dow Corning 200 is a trademark of Dow Corning Corporation, U.S.A.
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Figure 3-23: Reassemble transducer components

A. Feed thru cable seal
B. Retaining ring
C. Shoulder washer
D. Spring
E. Transducer capsule
F. Transducer housing

15. Slide the feed-thru cable seal along the cable towards the transducer housing. Insert
the feed thru cable seal into the housing groove with the retaining ring pliers.

16. Repeat Step 2 through Step 15 for the second transducer housing.
17. Apply electrical power to the meter.
18. Connect to the meter with MeterLink and run the Zero Flow Calibration Wizard;

select the Calibrate → Zero Calibrate menu and generate the report. Then, collect
and save a Maintenance log to show the “as left” condition of the meter. Or use
AMS™ Device Manager or a HART® Field Communicator and select Overview  → 
Zero Calibration → Start menu or Service Tools → Maintenance → Zero Calibration 
→ Start.

19. Close your application connection (MeterLink, AMS™ Device Manager or HART® Field
Communicator).

20. Reinstall the shroud:
• Install bolted band shrouds
• Install clamped band shrouds
• Install split shrouds
• Install latched band shroud

21. Reseal the meter electronics and shroud, if required (see Shrouds installation).
This completes the transducer housing and seal replacement procedure.
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3.7  Transducers replacement
This section discusses replacing the transducers for direct mount and remote mount
electronics options specific to your meter size (2 - 3-in, 4 - 10-in., and 12-in. and larger
meters).
Tip
Liquid transducer capsules can be replaced a single transducer capsule at a time. They
do not need to be replaced in pairs. Average delay and delta times are based on the
transducer housing so they will not change in the meter configuration when transducer
capsules are replaced.

 WARNING
CUTTING HAZARD
Sharp edges may be present on the meter.
Wear appropriate personal protective equipment when working on the meter.
Failure to comply may cause serious injury.

 WARNING
FLUID CONTENTS MAY BE UNDER PRESSURE
When the meter is under pressure, DO NOT attempt to remove or adjust the transducer
housing.
Attempting to do so may release pressurized fluid, resulting in serious injury for personnel
or equipment damage.
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 WARNING
FLUID CONTENTS MAY BE HAZARDOUS
The meter must be fully depressurized and drained before attempting to remove the
transducer housing. If fluid leaks at the joint of the transducer housing and the body as the
transducer housing is unscrewed, immediately reinstall it.
Failure to comply may cause serious injury to personnel or equipment damage.

A. Transducer housing and meter body joint

3.7.1  Replace transducers for direct mount electronics
The meter has integrally mounted transducer cables that require you to disconnect the
cables from the terminal blocks inside the Base enclosure and remove the transducer
capsule from the housing. This includes removing the Transmitter Electronics Enclosure,
the Acquisition Module, the Base Enclosure and the Shroud assembly.
Table 3-7: Transducer removal tool list
Tools required
LT-10 or LT-11 transducer pair
Crescent wrench or channel lock pliers for cable glands and electrical conduit
7/16-in. wrench (11 mm)
⅜-in. drive ratchet wrench
⅜-in. drive - at least 3.5-in. extension (89 mm) with 7/16 (11 mm) socket wrench
¼-in. (7 mm) flat-blade screw driver
⅛-in. (3 mm) flat-blade screw driver (3 mm)
Allen wrench - size 3 mm (Rosemount™ P/N 2-4-9200-501)
Retaining ring pliers (Rosemount P/N 1-504-90-043)
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Table 3-7: Transducer removal tool list (continued)
Tools required
MeterLink, or AMS™ Device Manager or a HART® Field Communicator

Procedure
1. Disable electrical power to the meter.
2. Disassemble the shrouds. Refer to the appropriate sections below for your meter:

• Remove bolted band shrouds
• Remove clamped band shrouds
• Remove split shrouds
• Remove latched band shrouds

3. If the installation has rigid conduit, use a medium size crescent wrench and loosen
the hex nuts on the Transmitter Electronics Enclosure. This should allow enough
slack to remove the Transmitter Electronics Enclosure from the Base Enclosure. If
the installation uses flexible conduit, you may not need to disconnect it from the
Transmitter Electronics Enclosure.

Figure 3-24: Conduit removal

A. Transmitter electronics enclosure
B. Conduit gland fitting

4. Use a 7/16-in. (11 mm) wrench and remove the four hex head bolts and split lock
washers securing the Transmitter Electronics Enclosure to the Base Enclosure.
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Figure 3-25: Transmitter Electronics Enclosure and Base Enclosure removal

A. Transmitter electronics enclosure
B. Base enclosure bolts
C. Base electronics enclosure

5. Lift the Transmitter Electronics Enclosure off of the Base Enclosure to expose the
Acquisition Module wiring. Prop the Transmitter Electronics Enclosure on top of
the Base Enclosure and prepare to disconnect the Acquisition cable and transducer
terminal blocks.

6. Use a ⅛-in. (3 mm) flat blade screw driver to remove the Acquisition cable terminal
block screws. Unplug the Acquisition cable terminal block.

7. Use a ⅛-in. (3 mm) flat blade screw driver and remove the transducer wire terminal
blocks screws. Disconnect the transducer cable wires from the terminal blocks so
that the cables can be removed from the meter.

NOTICE
Ensure the transducer cables are labeled for the chord configuration (A1, A2, B1 and
B2).
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Figure 3-26: Acquisition Module cable and transducer wiring

A. Acquisition cable and terminal block
B. Transducer wiring and terminal blocks
C. Acquisition Module
D. Base Enclosure
E. Upper split shroud

8. Using a ¼-in. (7 mm) flat blade screw driver loosen and remove the three Acquisition
Module flat head screws, split lock washers, and flat washers then remove the
Acquisition Module from the Base Enclosure.

9. Remove the three Base Enclosure hex head bolts, shoulder washers, flat washers
and split lock washers with a 7/16-in. (11 mm) socket wrench. Then remove the Base
Enclosure from the meter body.
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Figure 3-27: Base Enclosure removal

A. Transducer wiring terminal blocks (must be disconnected from transducer cables)
B. Hex hex bolts
C. Base Enclosure O-ring

10. Pull the transducer cable from the transducer to be replaced (down through the
foam feed-thru cable seal on top of the meter body and the base cover gasket.

11. If it is a split shroud meter, pull cable through the top hole in top shroud (Figure
3-28).

Figure 3-28: Split shroud transducer cable seal and gasket

A. Base enclosure
B. Feed-thru cable seal
C. Base cover gasket
D. Nylon flat washers

12. If it is a band shroud meter, remove all foil tape from the body top and circular
grooves and remove the cable from the grooves. Repeat this procedure for each
transducer pair you are removing.
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Figure 3-29: Bolted band shroud transducer removal

A. Base enclosure
B. Transducer cable with foil tape
C. Transducer cable circular grooves
D. Feed-thru cable seal

13. Use Retaining Ring pliers to pull the transducer feed-thru cable seal from the
transducer housing.
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Figure 3-30: Remove transducer from housing

A. Feed-thru cable seal removal
B. Retaining ring pliers

14. Slide the feed-thru cable seal down the cable.

Figure 3-31: Feed thru cable seal removal

A. Feed-thru cable seal

15. Use the retaining ring pliers and remove the retaining ring, shoulder washer, and
spring from the transducer housing.

16. Pull the transducer capsule from the housing.

Meter maintenance Maintenance and Troubleshooting Manual
November 2023  00809-0100-3812

64 Emerson.com/Rosemount



Figure 3-32: Transducer removal

A. Feed-thru cable seal
B. Shoulder washer
C. Spring
D. Transducer capsule

Figure 3-33: LT-10 Transducer and cable assembly removed from meter

17. Prepare to install a new transducer pair and the cable assembly.
18. Place one drop of Dow Corning 200 Silicon Oil(5) (12,500 Centistokes) (P/N

1-360-01-650) on the face of the transducer to be installed.
19. Insert the transducer capsule into the transducer housing in the meter body.
20. Slide the spring and shoulder washer along the cable to the transducer capsule.
21. Install the retaining ring into the groove within the transducer housing while

compressing the spring by applying force to shoulder washer.

(5) Dow Corning 200 is a trademark of Dow Corning Corporation, U.S.A.
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Figure 3-34: Transducer cable assembly

A. Feed-thru cable seal
B. Retaining ring
C. Shoulder washer
D. Spring
E. Transducer capsule
F. Transducer housing

22. For band shroud meters only, loop the transducer cable at the transducer a couple
of turns. The loop must fit within the body transducer pocket.

a) Start placing the cable in the circular the body circular groove at the
transducer.

b) Use foil tape to hold the cable and loop in position.
c) Continue positioning the cable in the body circular groove and securing with

the tape. At the meter top, position the cable in the body top cable groove
and tape to hold.

d) Ensure that a flat surface will be available for the band shroud to be installed
without squeezing the transducer cable.

e) Repeat for each transducer being replaced.
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Figure 3-35: Transducer cable installation for band shroud meters

A. Meter body top circular cable groove and foil taped cable
B. Meter body circular cable groove
C. Transducer cable
D. Meter body transducer pocket

23. For split shroud meters only, feed the transducer cables through the hole in the
upper split shroud on top of the meter body.

Figure 3-36: Split shroud transducer cable installation

A. Upper shroud
B. Transducer cable
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24. Carefully feed the transducer cables through the center of the base enclosure foam
rubber gasket and the feed-thru foam cable seal and gasket, then into the hole in
the bottom of the base enclosure.

Figure 3-37: Upper shroud feed-thru cable seal

A. Base enclosure
B. Cable feed-thru seal
C. Gasket nylon flat washers
D. Base electronics gasket

25. Repeat Step 23 and Step 24 for each transducer pair you are replacing.
26. Using tape, mark each transducer cable with the transducer location to identify

which cable goes to which transducer (e.g., A1, A2, B1 and B2 are the transducer
location identity names).

NOTICE
Feed-thru foam seals tear easily. Carefully pull the transducer cables through the
seal to prevent ripping the feed-thru cable seal.

27. Reattach the Base Enclosure to the upper split shroud and the meter body with the
three shoulder washers, flat washers, split lock washers and hex head bolts. Tighten
the bolts with a 7/16-in. (11 mm) socket driver.
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Figure 3-38: Base Enclosure assembly

A. 7/8 hex head bolts (3)
B. Split lock washers (3)
C. Flat washers (3)
D. Nylon shoulder washers (3)
E. O-ring
F. Base enclosure

28. Apply Loctite® nickel anti-seize or equivalent to the three hex head bolts to prevent
loosening due to vibration during operation.

29. Place the Acquisition Module into the Base Enclosure, align the three holes of the
Acquisition Module with the three holes in the base enclosure and secure with the
three split lock washers and flat head screws (see Figure 3-39). Position the cables to
prevent pinching when the Acquisition Module is attached. Tighten the screws with
a flat blade screwdriver.
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Figure 3-39: Base enclosure and Acquisition Module installation

A. Acquisition module
B. Base enclosure

30. Cut the new transducer cable(s) to the correct length removing excess cable within
the base enclosure with allowance for the wiring terminations and connector
placement.

a) Strip back about 1.5-in. of the cable outer sheath and ¼-in. of insulation from
the wires.

b) When stripping the outer sheath of the transducer cable, do not cut into the
insulation of the individual wires.

31. The transducer cables have two wires and a bare drain wire that must be terminated
on the connector on the Acquisition Module. The red wire connects to the +
(positive) pin, the black wire connects to the - (negative) pin and the bare drain wire
connects to the S-pin (Shield). Reattach the transducer cables to the terminal blocks
with a ⅛-in. (3 mm) flat blade screw driver and screw the terminal block onto the
Acquisition Module for the corresponding transducer (A1, B1, A2, or B2). Make sure
the transducer wires have good contact with the terminal block and the terminal
block screws are tight.
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Figure 3-40: Transducer terminal block wiring

32. Repeat Step 30 and Step 31 for each transducer you are replacing.
33. Plug the Acquisition cable terminal block into J3 on the Acquisition board and

tighten the terminal block screws with a ⅛-in. (3 mm) flat blade screw driver.

Figure 3-41: Transducer wiring and Acquisition cable reassembled

A. Transducer wiring terminal blocks
B. Acquisition cable
C. Acquisition module
D. Base enclosure O-ring
E. Base enclosure

34. When you have completed wiring the transducer cables to the Acquisition Module,
check the Base Enclosure O-ring and reinstall it if necessary.

35. Reattach the Transmitter Electronics Enclosure to the Base Enclosure with the four
hex head bolts and lock washers. Tighten bolts with a 7/16-in. (11mm) wrench.
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36. Retighten or reattach the conduit to the Transmitter Electronics Enclosure using a
crescent wrench or channel lock pliers.

37. Apply electrical power to the meter.
38. Connect to the meter with MeterLink and run the Zero Flow Calibration Wizard;

select the Calibrate → Zero Calibrate menu and generate the report. Then, collect
and save a Maintenance log to show the “as left” condition of the meter. Or
use AMS™ Device Manager or a HART® Field Communicator and select Overview → 
Zero Calibration → Start menu or Service Tools → Maintenance → Zero Calibration 
→ Start.

39. Close your application connection (MeterLink, AMS™ Device Manager or HART® Field
Communicator).

40. For band shroud meters only, re-inspect the transducer cables being held in the
body top cable grooves and body circular grooves and re-inspect the cable loop at
the body transducer pocket. Ensure that the transducer cables will not be pinched
when the band shrouds are installed.

41. For split shroud meters only, inspect the transducer cables to be sure they will not
be pinched as the lower shroud is assembled. Make sure the transducer cables are
moved out of the way and will not be pinched when the shroud is reinstalled.

42. Reinstall the shroud:
• Install bolted band shrouds
• Install clamped band shrouds
• Install split shrouds
• Install latched band shroud

43. Reseal the meter electronics and shroud, if required (see Meter sealing).
This completes the transducer installation procedure for meters with direct mount
transmitter electronics.

3.7.2  Replace transducers remote mount transmitter electronics
The meter has integrally mounted transducer cables that require you to disconnect the
cables from the terminal blocks inside the Junction Box and remove the transducer capsule
from the housing. This includes removing the Junction Box assembly from the meter body
and disconnecting the terminal blocks and transducer cable wiring.
Table 3-8: Transducer removal tool list
Tools required
LT-10 or LT-11 transducer pair
Crescent wrench or channel lock pliers for cable glands and electrical conduit
7/16-in. wrench (11 mm)
⅜-in. drive ratchet wrench (10 mm)
⅜-in. drive (10 mm) - at least 3.5-in. extension (89 mm) with 7/16 (11 mm) socket wrench
¼-in. (7 mm) flat-blade screw driver
⅛-in. (3 mm) flat-blade screw driver
Allen wrench - size 3 mm (Rosemount™ P/N 2-4-9200-501)
Retaining ring pliers (Rosemount P/N 1-504-90-043)
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Table 3-8: Transducer removal tool list (continued)
Tools required
MeterLink, or AMS Device Manager or a Field Communicator

Procedure
1. Disable power to the meter.
2. Remove security seals, if installed.
3. Remove the shrouds. Refer to the appropriate sections below for your meter:

• Remove bolted band shrouds
• Remove clamped band shrouds
• Remove split shrouds
• Remove latched band shrouds

4. Use retaining ring pliers to pull the transducer feed-thru cable seal from the
transducer housing.

Figure 3-42: Remove transducer from housing

A. Feed-thru cable seal removal
B. Retaining ring pliers

5. Slide the feed-thru cable seal down the cable.
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Figure 3-43: Feed thru cable seal removal

A. Feed-thru cable seal

6. Use the retaining ring pliers and remove the retaining ring, shoulder washer, and
spring from the transducer housing.

7. Pull the transducer capsule from the housing.

Figure 3-44: Transducer removal

A. Feed-thru cable seal
B. Shoulder washer
C. Spring
D. Transducer capsule
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Figure 3-45: LT-10 Transducer and cable assembly removed from meter

8. Prepare to disassemble transducer cables from the terminal blocks inside the
Junction Box.

Figure 3-46: Remote mount meter electronics and Junction Box

A. Transmitter electronics enclosure
B. Base enclosure
C. Junction box
D. Transducer cable conduit
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9. Pull the transducer cable for the transducer to be replaced, down through the foam
feed-thru cable seal on and the base cover gasket. If a split shroud meter, pull cable
through the top hole in top shroud (Figure 3-47).

Figure 3-47: Split shroud transducer cable seal and gasket

A. Base enclosure
B. Feed-thru cable seal
C. Base cover gasket
D. Nylon flat washers

If a band shroud meter, remove all foil tape from the body top and circular grooves
and remove the cable from the grooves. Repeat this procedure for each transducer
pair you are removing.

Figure 3-48: Bolted band shroud transducer removal

A. Junction box
B. Transducer cable with foil tape
C. Transducer cable circular grooves
D. Feed-thru cable seal

10. Use a 7/16-in. (11 mm) wrench and remove the four hex head bolts and split lock
washers securing the junction box cover.
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Figure 3-49: Junction box disassembly

A. Junction box hex head bolts
B. Junction box cover and gasket
C. Terminal blocks
D. Terminal block mounting plate
E. Meter mount junction box
F. Nylon gasket and feed-thru foam cable seal

11. Use a ⅛-in. (3 mm) flat-blade screw driver and disconnect the transducer cable
wiring from the terminal blocks.

12. Remove the terminal blocks from the Junction box.
13. Use a flat blade screw driver and remove the terminal block mounting plate from

the junction box.
14. Use a 7/16-in. (11 mm) socket wrench and remove the three hex head screws, split

lock washers, flat washers, shoulder washers and lift the Junction box off of the
meter body.

15. Prepare to install the new transducer and the cable assembly.
16. Make sure the cables are labeled for the correct transducer (A1, A2, B1, and B2).
17. Place one drop of Dow Corning 200 Silicon Oil (12,500 Centistokes) (P/N

1-360-01-650) on the face of the transducer to be installed.
18. Insert the transducer capsule into the transducer housing inside the meter body.
19. Slide the spring, shoulder washer and retaining ring onto the transducer cable.

Insert these components into the transducer housing.
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Figure 3-50: Transducer cable assembly

A. Feed-thru cable seal
B. Retaining ring
C. Shoulder washer
D. Spring
E. Transducer capsule
F. Transducer housing

20. Insert the feed-thru cable seal into the housing groove with the retaining ring pliers
(see Figure 3-50).

21. For band shroud meters only, loop the transducer cable at the transducer a couple
of turns. The loop must fit within the body transducer pocket.

a) Place the cable into the circular body groove at the transducer.
b) Use foil tape to hold the cable and loop in position.
c) Continue positioning the cable in the body circular groove and securing with

the tape. At the meter top, position the cable in the body top cable groove
and tape to hold.

d) Ensure that a flat surface will be available for the band shroud to be installed
without squeezing the transducer cable. Repeat for each transducer being
replaced.
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Figure 3-51: Transducer cable installation for band shroud meters

A. Meter body top circular cable groove and foil taped cable
B. Meter body circular cable groove
C. Transducer cable
D. Meter body transducer pocket

22. For split shroud meters only, feed the transducer cables through the hole in the
upper split shroud on top of the meter body.
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Figure 3-52: Split shroud transducer cable installation

A. Upper shroud
B. Transducer cable

23. Carefully feed the transducer cables through the center of the Junction Box rubber
gasket and the feed-thru foam cable seal and gasket, then into the hole in the
bottom of the Junction Box.

Figure 3-53: Upper shroud feed-thru cable seal

A. Junction Box
B. Transducer wiring terminal blocks
C. Junction Box rubber gasket
D. Cable Feed-thru seal
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24. Repeat Step 21 and Step 22 for each transducer pair you are replacing.
25. Using tape, mark each transducer cable with the transducer location to identify

which cable goes to which transducer (e.g., A1, A2, B1 and B2 are the transducer
location identity names).

NOTICE
Feed-thru foam seals tear easily. Carefully pull the transducer cables through the
seal to prevent ripping the feed-thru cable seal.

26. Ensure the nylon flat washers are in place between the junction box and the gasket.
27. Reattach the Junction Box to the meter body with the three shoulder washers, flat

washers, split lock washers and hex head bolts. Tighten the bolts with a 7/16-in. (11
mm) socket driver. Apply a light coat of Loctite® 290 to the three bolts.

Figure 3-54: Junction box assembly

A. Junction box hex head bolts
B. Junction box cover and gasket
C. Terminal blocks
D. Terminal block mounting plate
E. Meter mount junction box
F. Junction Box rubber gasket and feed-thru foam cable seal
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Figure 3-55: Junction box installation

A. Transducer wiring terminal blocks
B. Feed-thru foam seal
C. Terminal block mounting plate
D. Junction box O-ring

28. Insert the three standoffs and apply a light coat of Loctite 290 to secure the
standoffs.

29. Position the transducer cables to prevent pinching when the terminal block
mounting plate is attached.

30. Replace the terminal block mounting plate into the junction box and secure with the
three split lock washers and flat head screws (see Figure 3-55). Apply a light coat of
Loctite 290 to the three bolts.

31. Cut the new transducer cable(s) to the correct length with allowance for the wiring
terminations. Strip back about 1.5-in.es of the cable outer sheath and ¼-in. of
insulation from the wires.
Note
When stripping the outer sheath of the transducer cable, do not cut into the
insulation of the individual wires.
The transducer cables have two wires and a bare drain wire that must be terminated
on in the Junction box terminal blocks as marked. The red wire connects to the +
(positive) pin, the black wire connects to the - (negative) pin and the bare drain wire
connects to the S-pin (Shield). Reattach the transducer cables to the terminal blocks
with a 3 mm flat blade screw driver and screw the terminal block onto the terminal
block mounting plate for the corresponding chord (A1, B1, A2, or B2). Make sure the
transducer wires have good contact with the terminal block and the terminal block
screws are tight.

32. Ensure the Junction Box O-ring seal is correctly installed and adjust if necessary.
33. Reinstall the Junction box cover plate with the four hex head bolts and lock washers.

Tighten bolts with a 7/16-in. (11 mm) wrench.
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34. Apply power to the meter.
35. Connect to the meter with MeterLink. Open the meter monitor (detailed) view and

verify the meter is acquiring data, the transducers have good signals and flow
profiles for the chords are displayed and run the Zero Flow Calibration Wizard; select
theCalibrate → Zero Calibrate menu and generate the report. Then, collect and save
a Maintenance log to show the “as left” condition of the meter. Or use AMS Device
Manager or a HART® Field Communicator and select Overview → Zero Calibration → 
Start menu or Service Tools → Maintenance → Zero Calibration → Start.

36. Close your application connection (MeterLink, AMS Device Manager or HART® Field
Communicator).

37. Reinstall the shroud:
• Install bolted band shrouds
• Install clamped band shrouds
• Install split shrouds
• Install latched band shroud

38. If required, install the security seals through the hex bolts in the Junction box cover
(see Seal the Junction Box for remote mount electronics option).
This completes the procedure for replacing the transducers on meters with remote
mount transmitter electronics option.

3.8  Meter electronics replacement
The following procedure should be performed by a qualified service technician or trained
personnel. Observe all warning before starting this procedure.
Electronics maintenance Tasks

Transmitter Electronics Enclosure
• Section 3.7.1 Replace the CPU Module (P/N

1-360-03-014)
• Section 3.7.2 Replace the fuse (Littlefuse

#218002.HXP)
• Section 3.7.3 Replace the Backplane (P/N

1-360-03-07)
• Section 3.7.5 Replace the Power Supply Board

(P/N 1-360-03-003)

Base Enclosure Electronics
• Section 3.7.6 Replace the Acquisition Module

for direct or remote mount electronics (P/N
1-360-03-013)

• Section 3.7.7 Replace the Acquisition cable
(P/N 1-360-01-595)

Table 3-9: Electronics maintenance tools list
Tools required
7/16-in. (12 mm) wrench or channel lock pliers for transducer housing
Retaining ring pliers (Rosemount P/N 1-504-90-043)
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Table 3-9: Electronics maintenance tools list (continued)
Tools required
⅛-in. (3 mm) flat-blade screw driver (3 mm)
¼-in. (7 mm) flat-blade screw driver
⅜-in. drive ratchet wrench
⅜-in. drive - extension - at least 3.5-in. long
7/16-in. socket wrench
3 mm Allen wrench (Rosemount™ P/N 2-4-9200-501)

3.9  Transmitter electronics maintenance
Should the meter require disassembly in the field (i.e., check boards, change switch
settings, or replace boards), to prevent electrostatic damage to the electronic boards,
always use a ground strap while handling the circuit boards. If one is not available, make
sure you are electrically discharged before touching the boards by first touching a metal
surface such as a ground lug on the meter body, piping or metal structure.

Figure 3-56: Liquid Ultrasonic Flow Meter electronics

A. Terminal end of transmitter electronics enclosure
B. Backplane board location
C. End cap security latch
D. Base enclosure with acquisition module

3.9.1  Replace the CPU Module
Procedure

1. Disable electrical power to the meter.
2. Refer to Table 3-9 for the tools required to complete this procedure.
3. Disconnect security seals on the Transmitter Electronics Enclosure, loosen the end

cap security latches using a 3 mm Allen wrench and remove both end caps from the
Transmitter Electronics Enclosure.

Meter maintenance Maintenance and Troubleshooting Manual
November 2023  00809-0100-3812

84 Emerson.com/Rosemount



4. If replacing the CPU Module (located closest to the terminal end of the enclosure) or
the Optional I/O Module, use a 3 mm flat blade screw driver and disconnect the CPU
Module terminal blocks (or the Optional I/O Module) terminal blocks).
Note
The Optional I/O Module is scheduled for future release.

Figure 3-57: CPU or Optional I/O Module replacement

A. Terminal end of transmitter electronics enclosure
B. CPU module
C. Optional I/O module
D. Power supply board
E. Fuse
F. Internal chassis ground

5. Grasp the module you want to replace and pull it out of the enclosure.
6. Insert the new CPU Module or I/O Module into the enclosure and firmly push until

the board is fully seated into the Backplane Board connectors.
7. Replace the terminal blocks for the CPU Module and/or the Optional I/O Module and

tighten the flat head screws with a 3 mm flat blade screw driver.
8. Connect to the meter with MeterLink™. Open the meter monitor (detailed) view

and verify the meter is acquiring data, the transducers have good signals and flow
profiles for the chords are displayed and run the Zero Flow Calibration Wizard; select
the Calibrate → Zero Calibrate menu and generate the report. Then, collect and save
a Maintenance log to show the “as left” condition of the meter. Or use AMS™ Device
Manager or a HART® Field Communicator and select Overview → Zero Calibration → 
Start menu or Service Tools → Maintenance → Zero Calibration → Start.

9. Close your application connection (MeterLink, AMS™ Device Manager or HART® Field
Communicator).

10. If you are not replacing other electronics, replace the end caps and security latches
(requires a 3 mm Allen wrench).
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11. If replacing other electronics or the fuse, continue with Replace the fuse, Replace
the Backplane, Replace the I.S. Barrier board, Replace the Power Supply Board
or Replace the Acquisition Module for direct or remote mount electronics before
replacing the end caps and sealing the enclosure.

12. If you encounter problems replacing the electronics, see the Emerson Customer
Support contact information on the front cover of this manual.

3.9.2  Replace the fuse
Procedure

1. Disable electrical power to the meter.
2. Refer to Meter electronics replacement for the tools required to complete this

procedure.
3. Disconnect the Transmitter Electronics Enclosure security seals, loosen the end cap

security latch (requires a 3 mm Allen wrench) on the terminal end of the enclosure
(see Figure 3-56) and remove the end cap.

4. Use a ¼-in. (7 mm) standard flat head screw driver and remove the fuse holder cap
(see Replace the CPU Module).

Figure 3-58: Fuse holder cap

A. Fuse holder cap

5. Remove the fuse from the holder.
6. Insert the replacement fuse (Littlefuse #218002.HXP) into the fuse holder.
7. Install the fuse cap into the holder and push until it is flush with the holder.
8. Turn the fuse cap clockwise ⅛ turn using a ¼-in. standard flat head screw driver.
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9. Connect to the meter with MeterLink™. Open the meter monitor (detailed) view
and verify the meter is acquiring data, the transducers have good signals and flow
profiles for the chords are displayed and run the Zero Flow Calibration Wizard; select
the Calibrate → Zero Calibrate menu and generate the report. Then, collect and save
a Maintenance log to show the “as left” condition of the meter. Or use AMS™ Device
Manager or a HART® Field Communicator and select Overview → Zero Calibration → 
Start menu or Service Tools → Maintenance  → Zero Calibration → Start.

10. Close your application connection (MeterLink, AMS Device Manager or HART® Field
Communicator).

11. If replacing other electronics, continue with Replace the Backplane, Replace the I.S.
Barrier board, Replace the Power Supply Board or Replace the Acquisition Module
for direct or remote mount electronics before installing the end caps and sealing
the enclosure. If you are not replacing other electronics, replace the end caps and
security latches (3 mm Allen wrench required) and if required, install the security
wire seals (see Seal direct or remote mount transmitter electronics enclosure).

12. If you are not replacing other electronics, replace the end caps and security latches
(requires a 3 mm Allen wrench). If required, install the security seals through the
hex bolts in the Junction box cover (see Seal the Junction Box for remote mount
electronics option).
This completes the fuse replacement procedure.

3.9.3  Replace the Backplane
Procedure

1. If replacing the Backplane board, remove power to the meter.
2. Refer to Table 3-9 for the tools required to complete this procedure.
3. Disconnect the Transmitter Electronics Enclosure security seals (see Figure 3-78),

loosen the end cap security latches (3 mm Allen wrench required, see Figure 3-56)
and remove both end caps.

4. Remove the CPU Module and the Optional I/O Module. See Figure 3-57 for board
locations and associated terminal blocks.

5. Use a Phillips head screw driver and remove the four Backplane board screws and
captive star washers from the enclosure standoffs.

6. Pull the Backplane board out of the enclosure. This disconnects the I.S. Barrier
Board. Lay the Backplane board down with the Acquisition Cable still attached (the
Power Supply board may remain attached to the Backplane when you remove it
from the enclosure).
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Figure 3-59: Backplane board replacement

A. Non-terminal end of Transmitter Electronics Enclosure
B. Power Supply board
C. I.S. Barrier board (inside the Guide Plate)
D. Backplane board

7. Use a ⅛-in. (3 mm) flat head screw driver and disconnect the Acquisition
Cable terminal block from the Backplane. Unplug the Acquisition Cable from the
Backplane.

8. Remove the Power Supply (if it was not removed with the Backplane board) and I.S.
Barrier boards from the enclosure. The I.S. Barrier Board has a notched tab that
secures the board to the Guide Plate.

9. Attach the Acquisition Cable terminal block to the new Backplane Board and plug
the Power Supply Board and I.S. Barrier board into the Backplane board.

10. Insert the Backplane (with the Power Supply and I.S. Barrier Boards attached to the
Backplane) into the enclosure.

11. Fully seat the CPU Module and Optional I/O Module onto the Backplane board.
12. Install the four Phillips head screws to secure the Backplane to the enclosure

standoffs.
13. Reinstall the terminal blocks on the CPU Module, Optional I/O Module, and the

Power Supply board using a 3 mm flat head screw driver.

NOTICE
Make sure the terminal blocks are aligned with the guide plate openings.
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14. Recheck the connections, wiring and switch settings before replacing the end caps.
15. If replacing other electronics, continue with the following sections before replacing

the end caps and sealing the enclosure.
16. If you are not replacing other electronics, replace the end caps, security latches,

reseal the meter and apply power. If required, install the security seals through the
hex bolts in the Junction box cover (see Seal the Junction Box for remote mount
electronics option).

17. Apply power to the meter.
18. Connect to the meter with MeterLink™. Open the meter monitor (detailed) view

and verify the meter is acquiring data, the transducers have good signals and flow
profiles for the chords are displayed and run the Zero Flow Calibration Wizard; select
the Calibrate → Zero Calibrate menu and generate the report. Then, collect and save
a Maintenance log to show the “as left” condition of the meter. Or use AMS™ Device
Manager or a HART® Field Communicator and select Overview  → Zero Calibration → 
Start menu or Service Tools → Maintenance → Zero Calibration → Start.

19. Close your application connection (MeterLink, AMS™ Device Manager or HART® Field
Communicator).

20. This completes the Backplane board replacement procedure.
If you encounter problems with this procedure, see the Emerson Customer Support
contact information on the front cover of this manual.

3.9.4  Replace the I.S. Barrier board
Procedure

1. If replacing the I.S. Barrier board, remove power to the meter.
2. Refer to Table 3-9 for the tools required to complete this procedure.
3. Disconnect the Transmitter Electronics Enclosure security seals, loosen the end cap

security latches with a 3 mm Allen wrench and remove both end caps (see Figure
3-56).

4. Use a ⅛-in. (3 mm) flat head screw driver and remove the terminal blocks from the
Power Supply board, the CPU Module and the Optional I/O Module. See Figure 3-57
for board locations and associated terminal blocks.

5. Use a Phillips head screw driver and remove the four Backplane board screws from
the enclosure standoffs.

6. Pull the Backplane board out of the enclosure. This disconnects the I.S. Barrier
Board. Lay the Backplane board down with the Acquisition Cable still attached (the
Power Supply board may remain attached to the Backplane when you remove it
from the enclosure).
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Figure 3-60: I.S. Barrier board replacement

A. Non-terminal end of Transmitter Electronics Enclosure
B. Power Supply board
C. I.S. Barrier board (inside the Guide Plate)
D. Backplane board

7. Remove the I.S. Barrier Board from the Guide Plate on the right side of the
enclosure.

8. Install the new I.S. Barrier board onto the Backplane Board and seat the Power
Supply board onto the Backplane board.

9. Insert the Backplane, I.S. Barrier board and the Power Supply Board into the
enclosure.

10. Fully seat the CPU Module and Optional I/O Module onto the Backplane Board.
11. Attach the Backplane to the enclosure standoffs with the four Phillips head screws.
12. Reinstall the terminal blocks ⅛-in. (3 mm) flat head screw driver on the CPU Module,

Optional I/O Module, I.S. Barrier Board and the Power Supply.
13. Recheck the connections, wiring and switch settings before replacing the end caps.
14. Connect to the meter with MeterLink. Open the meter monitor (detailed) view and

verify the meter is acquiring data, the transducers have good signals and flow
profiles for the chords are displayed and run the Zero Flow Calibration Wizard; select
the Calibrate → Zero Calibrate menu and generate the report. Then, collect and save
a Maintenance log to show the “as left” condition of the meter. Or use AMS™ Device
Manager or a HART® Field Communicator and select Overview → Zero Calibration → 
Startmenu or Service Tools → Maintenance → Zero Calibration → Start.

15. Close your application connection (MeterLink, AMS™ Device Manager or HART® Field
Communicator).

Meter maintenance Maintenance and Troubleshooting Manual
November 2023  00809-0100-3812

90 Emerson.com/Rosemount



16. If replacing other electronics, continue with the following procedures before
replacing the end caps and sealing the enclosure.

17. If you are not replacing other electronics, replace the end caps and security latches
(3 mm Allen wrench required). If required, install the security seals (see Seal the
Junction Box for remote mount electronics option).

18. Apply power to the meter.
This completes the I.S. Barrier Board replacement procedure.
If you encounter problems with this procedure, see the Emerson Customer Support
contact information on the front cover of this manual.

3.9.5  Replace the Power Supply Board
Procedure

1. If replacing the Power Supply board, disable electrical power to the meter.
2. Refer to Table 3-9 for the tools required to complete this procedure.
3. Disconnect the Transmitter Electronics Enclosure security seals, loosen the end cap

security latches with a 3 mm Allen wrench and remove both end caps.
4. Use a ⅛-in. (3 mm) flat head screw driver and remove the terminal blocks from the

Power Supply board, the CPU Module and the Optional I/O Module. See Figure 3-57
for board locations and associated terminal blocks.

5. Use a #1 Standard Phillips head screw driver and remove the four Backplane board
screws from the enclosure standoffs.
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Figure 3-61: Power Supply Board replacement

A. Non-terminal end of Transmitter Electronics Enclosure
B. Power Supply board
C. I.S. Barrier board (inside the Guide Plate)
D. Backplane board

6. Pull the Backplane board out of the enclosure. This disconnects the I.S. Barrier
Board. Lay the Backplane board down with the Acquisition Cable still attached (the
Power Supply board may remain attached to the Backplane when you remove it
from the enclosure).

7. Plug the new Power Supply board and the I.S. Barrier Board onto the Backplane
Board.

8. Insert the Backplane, I.S. Barrier board and the Power Supply Board into the
enclosure and fully seat the CPU Module and Optional I/O Module.

9. Attach the Backplane to the enclosure standoffs with the four Phillips head screws.
10. Use a ⅛-in. (3 mm) flat blade screw driver and install the terminal blocks on the CPU

Module, Optional I/O Module, I.S. Barrier Board and the Power Supply.
11. Recheck the connections, wiring and switch settings before replacing the end caps.
12. Connect to the meter with MeterLink. Open the meter monitor (detailed) view and

verify the meter is acquiring data, the transducers have good signals and flow
profiles for the chords are displayed and run the Zero Flow Calibration Wizard; select
the Calibrate → Zero Calibrate menu and generate the report. Then, collect and save
a Maintenance log to show the “as left” condition of the meter. Or use AMS Device
Manager or a HART® Field Communicator and select Overview → Zero Calibration → 
Start menu or Service Tools → Maintenance → Zero Calibration → Start.
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13. Close your application connection (MeterLink, AMS Device Manager or HART® Field
Communicator).

14. If replacing other electronics, see Replace the CPU Module through Replace the I.S.
Barrier board before replacing the end caps and sealing the enclosure.

15. If you are not replacing other electronics, replace the Transmitter Electronics
Enclosure end caps, install the end cap security latches (3 mm Allen wrench
required). If required, install the security seals (see Seal the Junction Box for remote
mount electronics option).

16. Apply power to the meter.
This completes the Power Supply Board replacement procedure. If you encounter
problems with this procedure, see the Emerson Customer Support contact
information on the front cover of this manual.

3.9.6  Replace the Acquisition Module for direct or remote
mount electronics
Procedure

1. Disable electrical power to the meter.
2. Refer to Table 3-9 for the tools required to complete this procedure.
3. If the installation has rigid conduit, use a medium size crescent wrench and loosen

the hex nuts on the Transmitter Electronics Enclosure. This should allow enough
slack to remove the Transmitter Electronics Enclosure from the Base Enclosure. If
the installation uses flexible conduit, you may not need to disconnect it from the
Transmitter Electronics Enclosure.

Figure 3-62: Conduit removal

A. Transmitter electronics enclosure
B. Conduit gland fitting

4. If the meter is equipped with security seals, remove the seals from the bolts on the
Base Enclosure.
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Figure 3-63: Transmitter Electronics Enclosure and Base Enclosure security seal
removal

A. Transmitter electronics enclosure
B. Base enclosure bolts and security seals

5. For direct mount electronics, Use a 7/16-in. (11 mm) wrench and remove the four
hex head bolts and split lock washers securing the Transmitter Electronics Enclosure
to the Base Enclosure.

Figure 3-64: Transmitter Electronics Enclosure removal - direct mount option

A. Transmitter electronics enclosure
B. Base enclosure bolts
C. Base enclosure

For remote mount electronics, if necessary, loosen the mounting bracket bolts and
lower the Transmitter Electronics Enclosure and the Base Enclosure to a suitable
working level.
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Figure 3-65: Transmitter Electronics Enclosure removal - remote mount option

A. Transmitter electronics enclosure
B. Electronics mounting bracket
C. Base enclosure
D. Acquisition cable conduit

6. Use a 7/16-in. (11 mm) wrench and remove the four hex head bolts and split lock
washers securing the Base Enclosure.

7. Use a ⅛-in. (3 mm) flat head screw driver and disconnect the Acquisition cable
terminal block and the transducer wire terminal blocks from the Acquisition Module
inside of the Base enclosure.
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Figure 3-66: Acquisition Module cable and transducer wiring

A. Transducer wiring terminal blocks
B. Acquisition cable
C. Acquisition Module
D. Base Enclosure O-ring

NOTICE
Ensure the transducer cables are labeled for the chord configuration (A1, A2, B1 and
B2).

8. Remove the three Acquisition Module flat head screws and split lock washers, then
remove the Acquisition Module from the Base Enclosure or the Junction Box.

9. Insert the new Acquisition Module into the Base Enclosure and secure with the three
split lock washers and flathead screws.

10. Reattach the terminal blocks onto the Acquisition Module ⅛-in. (3 mm) flat head
screw driver for the corresponding transducer (A1, B1, A2, or B2). Make sure the
transducer wires have good contact with the terminal block and the terminal block
screws are tight.

11. When you have completed attaching the terminal blocks to the Acquisition Module,
check the Base Enclosure or Junction Box O-ring seal and reinstall if necessary.

12. Reattach the Transmitter Electronics Enclosure to the Base Enclosure with the four
hex head bolts and lock washers. Tighten bolts with a 7/16-in. (11 mm) wrench.
For the remote mount electronics option, lift the Transmitter Electronics Enclosure
and the Base unit to the its original height and retighten the mounting bracket
bolts.

13. Retighten or reattach the conduit to the Transmitter Electronics Enclosure using a
crescent wrench or channel lock pliers. Apply conduit sealing compound according
to manufacturer’s recommendations.

14. Connect to the meter with MeterLink. Open the meter monitor (detailed) view and
verify the meter is acquiring data, the transducers have good signals and flow
profiles for the chords are displayed and run the Zero Flow Calibration Wizard; select
the Calibrate → Zero Calibrate menu and generate the report. Then, collect and save
a Maintenance log to show the “as left” condition of the meter. Or use AMS™ Device
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Manager or a HART® Field Communicator and select Overview → Zero Calibration → 
Start menu or Service Tools → Maintenance → Zero Calibration → Start.

15. Close your application connection (MeterLink, AMS™ Device Manager or HART® Field
Communicator).

16. Install the end cap security latches using a 3 mm Allen wrench.
17. If required, install the security seals (see Seal the Junction Box for remote mount

electronics option).
18. Apply electrical power to the meter.

This completes the Acquisition Module replacement procedure.

3.9.7  Acquisition cable replacement
Replacing the Acquisition cable (Rosemount™ P/N 1-360-01-595) requires removing the
Transmitter Electronics Enclosure from the Base Enclosure, disconnecting the Acquisition
cable terminal block from Backplane board, disconnecting the CPU and Power Supply
terminal blocks and disconnecting the Acquisition cable from the Acquisition Module in the
Base Enclosure.
Emerson recommends that you contact Emerson Customer Support (see contact
information on the front cover of this manual) if you need to replace the Acquisition cable.

3.10  Shrouds installation

3.10.1  Install bolted band shrouds
 WARNING

CUTTING HAZARD
Sharp edges may be present on the band shrouds.
Wear appropriate personal protective equipment when working on the meter.
Failure to comply may cause serious injury.

Table 3-10: Band shroud installation tool list
Tools required
Standard ½-in. socket wrench or a standard ½-in. wrench
Appropriate personal protective equipment

Before starting shroud assembly check around the body outside diameter to be sure all of
the transducer cables have been postponed within the transducer machined pockets and
the cable grooves on the body surface. If the cables are not positioned correctly the cable
may become damaged and shroud assembly may not be possible.
Procedure

1. Assemble a lock washer onto the four shroud bolts and place all of the bolts within
reach of the meter.
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Figure 3-67: Bolted band shroud

A. End shroud installed
B. Bolted band shroud

2. Bolted band shroud assembly:
a) New bolted band shrouds: Grasp the shroud by the end edges and bow the

shroud with the brushed finish side of the shroud as the outside surface.
Position the bowed shroud (center of the length) over the top of meter body,
under the electronics enclosures and over the end of the meter body.

b) Used bolted band shrouds: Previously installed bolted band shrouds will
already be bowed. Grasp the end edges and position the bowed shroud
(center of the length) over the top of the meter body, under the electronics
enclosures and over the end of the meter body.

3. Align the hole near the end of the shroud with the tapped hole in the body OD and
insert the bolt with lock washer into the meter body hole.
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Figure 3-68: Bolted band shroud - meter bottom view

A. Bolted band shroud
B. End shrouds
C. Bolt with lock washer installed

4. Hand tighten the bolt a few turns. Bend the shroud around the body OD and align
the hole near the other end of the shroud with the second tapped hole in the body
OD. Insert another bolt with lock washer and hand tighten.

5. Fully tighten one band shroud bolt.
6. Position the shroud as tightly to the meter body as possible and fully tighten the

shroud bolt.
7. Assemble the two end shrouds on to the end of the large outside diameter of the

body. Position the two end shrouds to cover the entire end surface aligning the two
holes created by joining the edges of the two end shrouds with the tapped holes in
the body end.

8. While holding the end shrouds, insert one shroud bolt with lock washer into the
tapped hole and tighten wrench tight. Repeat with the second shroud bolt with lock
washer.

9. Repeat Step 1 thru Step 8 to install the second bolted band shroud and two end
shrouds.
This completes the assembly of the bolted band shrouds.

3.10.2  Install clamped band shrouds
 WARNING

CUTTING HAZARD
Sharp edges may be present on the band shrouds.
Wear appropriate personal protective equipment when working on the meter.
Failure to comply may cause serious injury.

Table 3-11: Clamped band shroud installation tool list
Tools required
Standard ½-in. (13 mm) socket wrench or a standard ½-in. (13 mm) wrench
Appropriate personal protective equipment
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Before starting shroud assembly, check around the body outside diameter to be sure all
of the transducer cables have been positioned correctly within the transducer machined
pockets and the cable grooves on the body outside diameter surface. If the cables are not
positioned correctly, the cable may become damaged.
Procedure

1. Place each half of the clamped band shroud assembly with a edge on a flat surface.
Position the parts to so they are circular with the ends with bent edges near each
other. Guide the bent edges to fit within each other completing the engagement of
the sheet metal hem bend. Be sure that full engagement is achieved and that the
edges of both parts remain on the flat surface.

Figure 3-69: Band shroud assembly

A. Worm screw clamps
B. Guide pins
C. Clamped band shroud
D. End shroud assembly

2. One end of the clamped band shroud assembly has two holes which will engage
guide pins and rectangular shaped holes. Assemble one nut end of a worm screw
clamp into one of these rectangular holes.
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Figure 3-70: Clamped band shroud assembly

A. Worm screw clamp part
B. Worm screw nut part
C. Rectangular shroud hole
D. Shroud guide pin hole

3. Insert the "T" shaped end of the clamp part into the rectangular shaped hole
and rotate the clamp part so the flat surface opposite of the nut is flat against
the outside surface of the band shroud. Extend the nut end of the clamp part
beyond the end of the band shroud. Once in place, use tape to keep the clamp
part positioned. Repeat to install a second worm screw clamp part into the second
rectangular hole near the other guide pin hole. Be sure the tape used does not
cover the guide pin holes.

4. The other end of the clamped band shroud assembly receives the threaded parts of
the worm screw clamps. Insert the "T" shaped end of a threaded clamp part into into
the rectangular shaped hole and rotate the clamp part so the flat surface opposite
of the nut is flat against the outside surface of the band shroud. Extend the length
of the clamp part threads beyond the end of the band shroud. Secure the clamp
part with tape to the band shroud. Repeat to install a second worm screw clamp
threaded part into the second rectangular hole on this end of the band shroud.

5. Grasp the clamped band shroud assembly by opposing edges and spread the
opening of the circular shape and place over the body outside diameter at a
machined shroud channel.

a) Position the shroud end with the guide pin holes and worm screw clamp nuts
on the same side of the meter which has the guide pins.

b) Align the guide pin holes in the shroud with the guide pins in the body and
hold this band shroud end against the body outside diameter.

c) Position the opposite end of the band shroud near to the guide pin hole
end and engage the worm screw clamp thread ends into the worm screw
clamp nuts. With a flat blade screwdriver or 5/16-in. (8 mm) hex driver rotate
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the worm screw clamp nuts, each a little at a time, until the band shroud
becomes snug against the body outside diameter.

Figure 3-71: Band shroud assembly

A. Worm screw clamps
B. Guide pins

6. Check the shroud for proper fit on the meter body and continue tightening the
worm screws.

a) Check to confirm that the band shroud assembly fully covers the body
transducer pockets.

b) Check to confirm that the hem bends assembly of the two shroud parts,
located at the bottom of the meter, are fully engaged.

c) If the shroud is misaligned, use a flat blade screw driver and loosen both
worm screw clamp assemblies by alternating between the two worm screw
clamp screws, turning each a few turns at a time. Reposition the misaligned
band.

7. Install the top end shroud cap over the worm screw clamps and insert the end
shroud pins into the Base electronics shroud.
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Figure 3-72: 12-in. and larger meters band shroud

A. Top end shroud
B. End shroud security seal and bolts
C. Base electronics shroud

8. Align the top end bolt holes with the two tapped holes in the body end pocket.
9. Place a lock washer onto a top end shroud bolt and install the bolt into the tapped

hole in the body end. Rotate the bolt clockwise and tighten with a ½-in. wrench.
Repeat this with another bolt and lock washer into the second hole in the body end.

10. Repeat Step 2 through Step 9 for the second clamped shroud.
11. If required, install band shroud security seals. Install the security seal wire into and

through one of the two holes in the shroud bolts (Shroud sealing).
This completes the clamped band shroud installation procedure.

3.10.3  Install split shrouds
 WARNING

CUTTING HAZARD
Sharp edges may be present on the band shrouds.
Wear appropriate personal protective equipment when working on the meter.
Failure to comply may cause serious injury.

Procedure
1. For direct mount electronics, install the upper split shroud during the assembly

of the Base Enclosure or, for remote mount electronics, during the junction box
assembly.

2. Check the transducer cables for the correct position or secure them with tape so the
split shroud installation will not interfere with or pinch the cables.

3. Position the lower split shroud below the meter body with the arch cutout aligned
with the body cylindrical shape.
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Figure 3-73: Lower Shroud installation

A. Upper split shroud
B. Hex head nut with external tooth lock washer
C. Shroud clamp and tab
D. Lower split shroud

4. Lift the lower shroud aligning the four studs of the lower split shroud into the slot of
the upper split shroud. When correctly aligned, fully engage the lower split shroud
with the upper split shroud in the slots of the upper shroud.

5. Install one split shroud clamp onto a lower shroud stud. Align the angled tabs of the
clamps to fit over the angled tabs of the upper shroud. Secure the clamp in place
using a hex nut with attached external tooth lock washer.

6. Tighten the nut with a 7/16 (11 mm) wrench. Repeat this at each of the stud
locations using additional nuts.

7. If required, attach the security wire seals on the Transmitter Enclosure end caps and
through the hex head bolts on the Base Enclosure and if required, install security
seals on the split shroud. Refer to Meter sealing for detailed sealing instructions.
This completes the split shroud installation procedure.

3.10.4  Install latched band shroud
Latched band shrouds are utilized on 2-in. to 10-in. ultrasonic meters.
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Figure 3-74: 3812 Liquid Ultrasonic Flow Meter assembly with latched band shroud

A. Latched band shroud

 WARNING
CUTTING HAZARD
Sharp edges may be present on the band shrouds.
Wear appropriate personal protective equipment when working on the meter.
Failure to comply may cause serious injury.

Use the following instructions to install the latched band shrouds covering the meter body
and transducer assemblies. If required, install the latch security wires. Before starting
shroud assembly, check around the body outside diameter to be sure all of the transducer
cables are positioned so the shroud does not pinch or crimp the cables.
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Figure 3-75: Latched band shroud assembly

A. Band shroud
B. Stainless steel strike
C. Transducer cable
D. Meter body recess for pop rivet allowance
E. Meter body shoulder
F. Shroud latch

Procedure
1. Grasp the band shroud assembly by opposing edges and spread apart.
2. Place over the body outside diameter.
3. Align the shroud’s inside edges so they are flush against the meter body shoulder

(see Figure 3-75).
4. Hold the shroud snugly against the meter body and position the latch and strike so

they are centered on the bottom of the meter body.
5. Lift the latch and over the strike and press down firmly.
6. Repeat Step 1 through Step 5 for the other band shroud.
7. Visually inspect the shrouds covering for proper fit on the meter body. Ensure the

bands are flush against the body shoulders and the latches are evenly aligned.
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Figure 3-76: Band shroud latches and security wire seals holes

A. Left shroud latch holes for security wire seals
B. Strike
C. Retainer
D. Latch
E. Right shroud holes for security wires

8. If required, install the security seal wire into and through the holes in one of the
shroud latches (maximum wire diameter .078-in.; 2.0 mm).

9. Remove all slack and seal.
10. Cut wire ends to remove excess wire.
11. Repeat these steps for the other shroud latch.

This completes the split shroud security seal installation procedure.

3.11  Meter sealing

3.11.1  Seal direct or remote mount transmitter electronics
enclosure
Security seals protect the integrity of the meter metrology and prevent tampering with
transducer assemblies. The following sections detail how to properly seal the Rosemount™
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3812 Liquid Allocation Ultrasonic Flow Meter after commissioning. The security seal wires
are commercially available.
Be sure to set the WRITE PROT. switch on the CPU Module to the ON position prior to
sealing the enclosure.
Use the following instructions to install the security seal wires on the Transmitter
Electronics Enclosure.

Figure 3-77: Transmitter electronics enclosure security latch

A. Transmitter Electronics Enclosure end cap
B. Security latch

Procedure
1. Rotate the end cap clockwise fully closing and compressing the end cap seal. Install

the Security latch using a 3 mm Allen wrench.
2. Install the security seal wire into and through one of the two holes in the end cap.

Choose holes that minimize counterclockwise rotation of the end cap when the
security wire is taut (maximum wire diameter .078-in.; 2.0 mm).
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Figure 3-78: Transmitter electronic enclosure security seals

A. Transmitter Electronics Enclosure end cap
B. Security wire seals

3. Adjust the security wire, removing all slack and thread into the lead seal.
4. Cut wire ends to remove excess wire.

This completes installing the Transmitter Electronics Enclosure security wire seals.

3.11.2  Seal direct or remote mount Base electronics enclosure
Use the following instructions to install the security seal wire on the Base Enclosure.
Procedure

1. Install security wire seal into and through two of the four the holes in the socket
head screws on the Base Enclosure cover (maximum wire diameter .078-in.; 2.0
mm).
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Figure 3-79: Base Enclosure security seals

A. Base Enclosure
B. Security wire seals

2. Position the wire to prevent counterclockwise rotation of the screws when the seal
wire is taut.

3. Twist and adjust wire removing all slack and seal.
4. Cut wire ends to remove excess wire.

3.11.3  Seal the Junction Box for remote mount electronics option
Use the following instructions to install the security seal wire on the junction box, if
required.
Procedure

1. Install security wire seal into and through two of the four the holes in the socket
head screws on the Junction Box cover (maximum wire diameter .078-in.; 2.0 mm).
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Figure 3-80: 3812 Remote mount transmitter electronics option

A. Junction Box socket head screws

2. Position the wire to prevent counterclockwise rotation of the screws when the seal
wire is taut.

3. Twist and adjust wire removing all slack and seal.
4. Cut wire ends to remove excess wire.

This completes installing security seals on the Junction Box.

3.11.4  Shroud sealing
Security seals protect the integrity of the meter metrology and prevent tampering with
transducer assemblies. The following sections detail how to properly seal the Rosemount™

3812 Liquid Allocation Ultrasonic Flow Meter after commissioning or maintenance
procedures. The security seal wires are commercially available.

 WARNING
CUTTING HAZARD
Sharp edges may be present on the band shrouds.
Wear appropriate personal protective equipment when working on the meter.
Failure to comply may cause serious injury.
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Bolted band shroud security seals
Use the following instructions to install the security seal wires, if required, on the band
shrouds for 2-in. - 3-in. meters.
Procedure

1. On the underneath side on the meter, install the security wires into and through
both of the two holes in the shroud bolts as shown in Figure 3-81 (maximum wire
diameter .078-in.; 2.0 mm). Position the wire to prevent counterclockwise rotation of
the screws when the seal wire is taut.

Figure 3-81: Bottom view band shroud security seals

A. Band shroud ¼-in.- 20 bolts
B. End band shroud bolts

2. Adjust the security wire, removing all slack and thread into the lead seal.
3. Cut wire ends to remove excess wire.

This completes the bolted band shroud security seal installation procedure.

Clamped band shroud security seals
Use the following instructions to install the security seal wires, if required, on the two top
end shrouds covering the worm screw clamps. This procedure applies to clamped band
shroud meters.
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Figure 3-82: Shroud security seals

A. Top end shroud
B. Security wire seals

Procedure
1. Install the security seal wire into and through the two bolt holes on the top end

shrouds (maximum wire diameter .078-in.; 2.0 mm). Position the wire to prevent
counterclockwise rotation of the screws when the seal wire is taut.

2. Remove all slack and seal.
3. Repeat previous step for the other top end shroud.
4. Cut wire ends to remove excess wire.

This completes the clamped band shroud security seal installation procedure.

Split shroud security seals
Use the following instructions to install the security seal wires on the split shroud covering
the meter body and transducer assemblies.
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Figure 3-83: Split shroud security seals

A. Upper split shroud
B. Split shroud clamp
C. Security wire seals
D. Lower split shroud

Procedure
1. Install the security seal wire into and through the holes in the split shroud clamp

bent tab and the upper split shroud bent tab. (maximum wire diameter .078-in.; 2.0
mm).

2. Remove all slack and seal.
3. Cut wire ends to remove excess wire.
4. Repeat these steps for the split shroud clamps.

This completes split band shroud security seal installation procedure.

Latched band shroud security seals
Use the following instructions to install the security seal wires on the latched band shrouds
covering the meter body and transducer assemblies.

Meter maintenance Maintenance and Troubleshooting Manual
November 2023  00809-0100-3812

114 Emerson.com/Rosemount



Figure 3-84: Latched band shroud assembly

A. Band shroud
B. Stainless steel strike
C. Transducer cable
D. Meter body recess for pop rivet allowance
E. Meter body shoulder
F. Shroud latch

Procedure
1. Install the security seal wire into and through the holes in one of the shroud latches

(maximum wire diameter .078-in.; 2.0 mm).
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Figure 3-85: Shroud latch holes for security wire seals

A. Left shroud latch holes for security wire seals
B. Right shroud holes for security wires

2. Remove all slack and seal.
3. Cut wire ends to remove excess wire.
4. Repeat these steps for the other shroud latch.

This completes the latched shroud security seal installation procedure.
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A  Conversion factors
A.1  Conversion factors per units of measurement

The following table includes conversion factors for many of the Metric and U.S. Customary
units of measure used with Rosemount 3812 Liquid Allocation Ultrasonic Flow Meters and
MeterLink™.
Table A-1: Conversion factors per units of measurement
Conversion factors Unit of measurement
(°F-32)x(5/9) -> °C
(°C+273.15) - > K
1 K/°C
5/9 °C/°F
10-6 MPa/Pa
0.006894757 MPa/psi
0.1 MPa/bar
0.101325 MPa/atm
0.000133322 MPa/mmHg
0.3048 m/ft
0.0254 m/in
103 dm3/m3

10-6 m3/cc (= m3/cm3)
(0.3048)3 m3/ft3

(0.0254)3 m3/in3

3600 s/h
86400 s/day
103 g/kg
0.45359237 kg/lbm
231 in3/gal
42 gal/bbl (barrel)
0.0037854 gal/m3

6.289811 bbl/m3

10-3 Pa•s/cPoise
1.488 Pa•s/(lb/(ft•s))
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A.2  K-Factor and inverse K-Factor
Equation A-1: Frequency volumetric flow rate K-FactorKFactor = FreqQFullScale(MaxFreq)3600s § ℎr( * )
and

Equation A-2: Frequency volumetric flow rate inverse K-FactorInvKFactor = (MaxFreq)(3600s § ℎr)( * )FreqQFullScale
where

KFactor = frequency “K-Factor” (pulses/volume**) (Freq1KFactor and Freq2KFactor)
InvKFactor = frequency “Inverse K-Factor” (volume**/pulse) (Freq1InvKFactor and
Freq2InvKFactor)
FreqQFullScale = frequency full-scale volumetric flow rate (volume**/time unit*)
(Freq1FullScaleVolFlowRate and Freq2FullScaleVolFlowRate)
MaxFreq = maximum frequency (Hz = pulses/time unit*) (Freq1MaxFrequency and
Freq2MaxFrequency)

(*) TimeUnit = time conversion factor depends on the VolFlowRate Time Unit data point:
• volume/second = 1 s/s
• volume/minute = 60 s/m
• volume/hour = 3600 s/h
• volume/day = 86400 s/d
(**) Volume = where the volume is selected via data points:
• Units System
• VolUnitUS

— gallons
— barrels

• VolUnitMetric
— cubic meters
— liters
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B  Engineering drawings
B.1  Rosemount 3812 Liquid Ultrasonic Flow Meter

drawings
This appendix contains the following engineering drawing(s) for the ultrasonic meter:

DMC-004936 Rosemount 3810 Liquid Ultrasonic Flow
Meter System Wiring Diagram

Maintenance and Troubleshooting Manual Engineering drawings
00809-0100-3812 November 2023

Rosemount 3812 Liquid Ultrasonic Flow Meter 119



Engineering drawings Maintenance and Troubleshooting Manual
November 2023  00809-0100-3812

120 Emerson.com/Rosemount



Maintenance and Troubleshooting Manual Engineering drawings
00809-0100-3812 November 2023

Rosemount 3812 Liquid Ultrasonic Flow Meter 121



00809-0100-3812
Rev. AC

2023

For more information: www.emerson.com
©2023 Emerson. All rights reserved.
Emerson Terms and Conditions of Sale are available 
upon request. The Emerson logo is a trademark and 
service mark of Emerson Electric Co. Rosemount is a 
mark of one of the Emerson family of companies. All 
other marks are the property of their respective owners.

http://www.emerson.com

	Rosemount 3812 Liquid Ultrasonic Flow Meters
	Contents
	1 Routine Maintenance
	1.1 Meter maintenance
	1.2 Field hydrostatic pressure testing procedures
	1.3 Routine maintenance
	1.3.1 Maintenance logs and reports
	1.3.2 Pipeline cleaning maintenance


	2 Troubleshooting
	2.1 Meter status alarms
	2.1.1 Check status
	2.1.2 System alarm
	2.1.3 Chord A and Chord B alarm
	2.1.4 Field I/O alarm
	2.1.5 Validity alarm
	2.1.6 Comms alarm
	2.1.7 Communications

	2.2 Troubleshooting the meter
	2.2.1 Meter monitoring maintenance
	2.2.2 Unable to connect direct serial or external serial modem
	2.2.3 Unable to connect to meter
	2.2.4 Ethernet connections
	2.2.5 Direct serial connections

	2.3 Troubleshoot maintenance log files and trend files
	2.3.1 Files do not appear in workbook
	2.3.2 Microsoft® Excel® Log/Export options are not available
	2.3.3 Maintenance Logs or Trend files are not created

	2.4 Meter reset mode

	3 Meter maintenance
	3.1 General maintenance tasks
	3.2 Important safety information
	3.3 3812 meter options
	3.4 Remove the shrouds
	3.4.1 Remove bolted band shrouds
	3.4.2 Remove clamped band shrouds
	3.4.3 Remove split shrouds
	3.4.4 Remove latched band shrouds

	3.5 Re-wet the transducers
	3.6 Transducer housings or housing seals replacement
	3.6.1 Replace transducer housing and seals

	3.7 Transducers replacement
	3.7.1 Replace transducers for direct mount electronics
	3.7.2 Replace transducers remote mount transmitter electronics

	3.8 Meter electronics replacement
	3.9 Transmitter electronics maintenance
	3.9.1 Replace the CPU Module
	3.9.2 Replace the fuse
	3.9.3 Replace the Backplane
	3.9.4 Replace the I.S. Barrier board
	3.9.5 Replace the Power Supply Board
	3.9.6 Replace the Acquisition Module for direct or remote mount electronics
	3.9.7 Acquisition cable replacement

	3.10 Shrouds installation
	3.10.1 Install bolted band shrouds
	3.10.2 Install clamped band shrouds
	3.10.3 Install split shrouds
	3.10.4 Install latched band shroud

	3.11 Meter sealing
	3.11.1 Seal direct or remote mount transmitter electronics enclosure
	3.11.2 Seal direct or remote mount Base electronics enclosure
	3.11.3 Seal the Junction Box for remote mount electronics option
	3.11.4 Shroud sealing
	Bolted band shroud security seals
	Clamped band shroud security seals
	Split shroud security seals
	Latched band shroud security seals



	A Conversion factors
	A.1 Conversion factors per units of measurement
	A.2 K-Factor and inverse K-Factor

	B Engineering drawings
	B.1 Rosemount 3812 Liquid Ultrasonic Flow Meter drawings



